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ΠΡΟΛΟΓΟΣ 
 

Το Internet αποτελεί σήµερα µια πραγµατικότητα και συγκεντρώνει το ενδιαφέρον 
του κόσµου της παραγωγής, του εµπορίου, αλλά και της πολιτείας, της επιστήµης και 
της εκπαίδευσης. Ολοένα και περισσότερες ανθρώπινες δραστηριότητες 
πραγµατοποιούνται µέσω του διαδικτύου και όλο και περισσότεροι άνθρωποι 
συνδέονται σε αυτό. Αποτελεί τον πυρήνα των τεχνολογικών εξελίξεων. Έχει 
καλύψει κάθε πτυχή της κοινωνικής, πολιτικής και οικονοµικής ζωής σε όλο τον 
πλανήτη. Οι ρυθµοί ανάπτυξης είναι πλέον ιλιγγιώδεις. Πολύ σύντοµα προβλέπεται 
ότι το κάθε σπίτι θα είναι συνδεδεµένο στον  ιστό, όπως ακριβώς διαθέτει τηλέφωνο 
και τηλεόραση. 
Η καρδιά όµως του διαδικτύου είναι οι ιστοσελίδες που αποτελούν το µέσο της 
άµεσης επαφής του µε τον χρήστη. Εποµένως ο ρόλος του σχεδιαστή ιστοσελίδων 
είναι πάρα πολύ σηµαντικός. Για να κάνει  πιο εύκολη τη δουλειά του ο σχεδιαστής, 
θα πρέπει να χρησιµοποιεί εφαρµογές που θα του εξοικονοµήσουν χρόνο και κόπο. 
Μια τέτοια εφαρµογή θα µελετήσουµε σ’ αυτήν την εργασία.   
    Σκοπός λοιπόν της εργασίας είναι η ανάπτυξη τους εκπαιδευτικού εργαλείου και 
ελληνικού εγχειριδίου χρήσης για ένα έτοιµο πακέτο µενού ιστοσελίδας. Αρχικά θα 
µελετηθούν δύο έτοιµα πακέτα δηµιουργίας µενού ιστοσελίδας από τα οποία θα 
επιλεχτεί το πλέον ισχυρό. Μετά τη µελέτη του έτοιµου αυτού προϊόντος θα παραχθεί 
µια εκπαιδευτική και παιδαγωγική documentation µε ικανοποιητικό αριθµό 
παραδειγµάτων. Το πακέτο αυτό θα πρέπει να είναι από τα ελευθέρως διατιθέµενα 
στο διαδίκτυο ή µικρού κόστους.  
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∆ΙΑ∆ΙΚΤΥΟ 

 
Στην γενική του έννοια ένα διαδίκτυο είναι δίκτυο ηλεκτρονικών υπολογιστών που 
(δια)συνδέει άλλα δίκτυα. Ο όρος internet προκύπτει από το αγγλικό inter-network. 
Στην ειδική του µορφή µε κεφαλαίο ∆ (∆ιαδίκτυο) εννοούµε το παγκόσµιο πλέγµα 
διασυνδεδεµένων υπολογιστών περιλαµβανοµένων και των υπηρεσιών και 
πληροφοριών που παρέχει στους χρήστες του. Το ∆ιαδίκτυο χρησιµοποιεί την 
µεταγωγική µετάδοση πακέτων (packet switching) και το πρωτόκολλο επικοινωνίας 
TCP/IP. Έτσι ο όρος διαδίκτυο κατέληξε να αναφέρεται στο παγκόσµιο αυτό δίκτυο. 
Η τέχνη της σύνδεσης δικτύων µε αυτό το τρόπο ονοµάζεται internetworking. 
 
 

Η ΓΕΝΝΗΣΗ ΤΟΥ ∆ΙΑ∆ΙΚΤΥΟΥ 
 

Τα θεµέλια του διαδικτύου τα έθεσε ο Vannevar Bush στο κείµενό του "As We May 
Think" για ένα "γαλαξιακό δίκτυο" συνδεδεµένων υπολογιστών. Ο πυρήνας του 
∆ιαδικτύου ξεκίνησε το 1969 µε την ονοµασία ARPANET στις Ηνωµένες Πολιτείες 
στην υπηρεσία προηγµένης αµυντικής έρευνας (Defense Advanced Research Projects 
Agency) (DARPA) του Υπουργείου άµυνας. Η αρχική έρευνα που συνέβαλε στο 
ARPANET περιελάµβανε εργασίες στα αποκεντρωµένα δίκτυα, queueing theory, και 
ανταλλαγή πακέτων packet switching. Στις 11 Ιανουαρίου, 1983, το ARPANET 
άλλαξε το βασικό του δικτυακό πρωτόκολλο επικοινωνίας από το NCP σε TCP/IP 
ξεκινώντας έτσι το ∆ιαδίκτυο όπως το ξέρουµε σήµερα. 
Ένα σηµαντικό βήµα στην ανάπτυξη έκανε το Εθνικό Ίδρυµα Επιστηµών (NSF) το 
οποίο έχτισε την Πανεπιστηµιακή ραχοκοκαλιά, το NSFNet, το 1986. Σηµαντικά 
διαφορετικά δίκτυα που έχουν επιτυχώς ενσωµατωθεί µέσα στο ∆ιαδίκτυο είναι 
µεταξύ των άλλων τα Usenet, Fidonet, και Bitnet. 
Στη δεκαετία του 1990, το ∆ιαδίκτυο προσάρµοσε επιτυχώς την πλειοψηφία των 
παλιότερων δικτύων υπολογιστών. Αυτή η ανάπτυξη συχνά αποδίδεται στην έλλειψη 
κεντρικής διοίκησης, η οποία επιτρέπει οργανική ανάπτυξη του δικτύου, όπως και 
στο µη-ιδιοκτησιακό καθεστώς των πρωτοκόλλων του ∆ιαδικτύου, τα οποία 
ενθάρρυναν την ευκολία στην εσωτερική λειτουργία των µικροπωλητών και 
απέτρεψαν µία και µόνο εταιρεία να ασκεί την επιρροή της σε όλο το δίκτυο. 
 
 

ΤΟ ∆ΙΑ∆ΙΚΤΥΟ ΣΗΜΕΡΑ 
 
Το ∆ιαδίκτυο συγκροτείται από αµφί- ή πολύπλευρα εµπορικά συµβόλαια (π.χ. 
οµότιµες συµφωνίες) και από τεχνικές προδιαγραφές ή πρωτόκολλα που περιγράφουν 
την ανταλλαγή δεδοµένων στο δίκτυο. Τα πρωτόκολλα αυτά µορφοποιούνται µε 
συζητήσεις µέσα στο Internet Engineering Task Force (IETF) και τις οµάδες εργασίας 
του, οι οποίες είναι ανοιχτές για δηµόσια συµµετοχή και κριτική. Αυτές οι επιτροπές 
παράγουν κείµενα που είναι γνωστά ως Αιτήµατα για Σχολιασµό (ΑΓΣ). Ορισµένα 
ΑΓΣ εγείρονται από την κατάσταση του Προτύπου ∆ιαδικτύου από το Συµβούλιο 
Αρχιτεκτονικής του ∆ιαδικτύου (IAB). 
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Μερικά από τα πιο γνωστά πρωτόκολλα Internet protocol suite είναι IP, TCP, UDP, 
DNS, PPP, SLIP, ICMP, POP3, IMAP, SMTP, HTTP, HTTPS, SSH, Telnet, FTP, 
LDAP και SSL. Μερικές από τις πιο γνωστές υπηρεσίες του ∆ιαδικτύου που 
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χρησιµοποιούν αυτά τα πρωτόκολλα Η/Τ (e-mail), Usenet newsgroups, file sharing, 
το World Wide Web, Gopher, session access, WAIS, finger, IRC, MUD, και MUSH. 
Από αυτά, το ηλεκτρονικό ταχυδροµείο (Η/Τ) και ο Παγκόσµιος Ιστός είναι τα πιο 
ευρέως χρησιµοποιούµενα, και πολλές άλλες υπηρεσίες έχουν βασιστεί πάνω σε 
αυτές, όπως ταχυδροµικές λίστες και αρχεία καταγραφής ιστού. Το ∆ιαδίκτυο 
καθιστά δυνατή τη διάθεση υπηρεσιών σε πραγµατικό χρόνο όπως ραδιόφωνο µέσω 
Ιστού και προβλέψεις µέσω Ιστού που µπορούν να προσπελαστούν από οπουδήποτε 
στον κόσµο. 
Μερικές ακόµα γνωστές υπηρεσίες του ∆ιαδικτύου δεν δηµιουργήθηκαν µε αυτόν τον 
τρόπο, αλλά βασίστηκαν αρχικά σε ιδιόκτητα συστήµατα. Αυτά περιλαµβάνουν IRC, 
ICQ, AIM, CDDB, και Gnutella. 
Υπάρχουν πολλές αναλύσεις για το ∆ιαδίκτυο και τη δοµή του. Π.χ. είναι 
καθορισµένο ότι η δοµή δροµολόγησης του ∆ιαδικτύου και οι υπερσύνδεσµοι του 
Παγκόσµιου Ιστού είναι παραδείγµατα µη κλιµακούµενων δικτύων. 
Όπως οι εµπορικοί παροχείς ∆ιαδικτύου συνδέονται µέσω σηµεία ανταλλαγής 
∆ιαδικτύου, τα ερευνητικά δίκτυα τείνουν να συνδέονται µεταξύ τους σε µεγάλα 
υποδίκτυα όπως: 
GEANT  
Internet2  
Little GLORIAD  
JANET  
 
 

Η ΚΟΥΛΤΟΥΡΑ ΤΟΥ ∆ΙΑ∆ΙΚΤΥΟΥ 
 
Το Ίντερνετ επίσης έχει µία µεγάλη επίδραση στην γνώση και τη διαµόρφωση 
απόψεων. Μέσα από την αναζήτηση κλειδιών χρησιµοποιώντας µηχανές αναζήτησης, 
όπως το Google, εκατοµµύρια ανθρώπων έχουν εύκολη και άµεση παγκόσµια 
πρόσβαση σε ένα τεράστιο πλήθος και ποικιλία από online πληροφορίες. 
Συγκρινόµενο µε εγκυκλοπαίδεια και παραδοσιακές βιβλιοθήκες, το Ίντερνετ 
αντιπροσωπεύει µία ξαφνική και απότοµη αποκέντρωση των πληροφοριών και 
δεδοµένων. Η γλώσσα που χρησιµοποιείται περισσότερο για την επικοινωνία στο 
Ίντερνετ είναι η Αγγλική κυρίως λόγω της καταγωγής του Ίντερνετ, της χρήσης της 
Αγγλικής στον προγραµµατισµό λογισµικού και στην αδυναµία των πρώτων γενιών 
υπολογιστών να χρησιµοποιήσουν άλλους χαρακτήρες πέραν του δυτικού 
Αλφάβητου. Το δίκτυο µεγάλωσε αρκετά τα τελευταία χρόνια και επαρκές 
περιεχόµενο είναι διαθέσιµο για τις γλώσσες των περισσότερο ανεπτυγµένων χωρών. 
Ωστόσο υπάρχουν ακόµα δυσλειτουργίες και τεχνικά προβλήµατα όπως το mojibake. 
 
 

ΝΟΜΙΚΑ ΚΑΙ ΗΘΙΚΑ ΖΗΤΗΜΑΤΑ 
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Υπάρχει µια γενική ανησυχία αναφορικά µε το ∆ιαδίκτυο που πηγάζει από µέρος του 
περιεχοµένου του που είναι αρκετά αµφισβητήσιµο. Η παραβίαση πνευµατικών 
δικαιωµάτων, η πορνογραφία, η ψευδοπροσωπία, η προσφορά παρανόµων προϊόντων 
είναι φαινόµενα παρόντα και εύκολα προσβάσιµα στο ∆ιαδίκτυο, και ο περιορισµός 
τους είναι ιδιαίτερα δύσκολος. Για παράδειγµα, η λέξη "sex" παραµένει µία από τις 
λέξεις που χρησιµοποιούνται περισσότερο για αναζήτηση στο ∆ιαδίκτυο µέσω 
µηχανών αναζήτησης. Συχνά, η ανησυχία αυτή, που θεωρείται από κάποιους 
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αβάσιµη, έχει ως αποτέλεσµα τον ηθικό πανικό, όπως έχει σηµειωθεί σε περιπτώσεις 
όπου εγκλήµατα ή αποτρόπαιες καταστάσεις έρχονται σε επαφή µε την κοινή γνώµη 
(συνήθως περιπτώσεις παιδεραστίας, ιστοσελίδες σατανιστών κ.ά.). 
Το ∆ιαδίκτυο έχει κατηγορηθεί ως παράγοντας που έπαιξε ρόλο σε θανάτους. Ο 
Μπράντον Βέντας(Brandon Vedas) πέθανε από υπερβολική δόση ενός µίγµατος 
νοµίµων και παρανόµων ναρκωτικών, παρακινούµενος από συνοµιλητές του στο 
IRC. Ο Σων Γούλευ(Shawn Woolley) αυτοκτόνησε µε πιστόλι, για λόγους που 
σχετίζονται µε τον εθισµό του µε το EverQuest, ένα Μαζικά Πολυχρηστικό 
∆ιαδικτυακό Παιχνίδι Ρόλων (MMORPG), όπως ισχυρίζεται η µητέρα του. Ο Άρµιν 
Μάιβες (Armin Meiwes) µαχαίρωσε µέχρι θανάτου και έφαγε τον Μπέρντ-Γιούργκεν 
Μπράντες (Rend-Jurgen Brandes) όταν ο τελευταίος απάντησε στην αγγελία του 
πρώτου που ζητούσε έναν "µεγαλόσωµο άνδρα έτοιµο να σφαγιαστεί και µετά να 
καταβροχθιστεί". 
 
 

ΠΡΟΣΒΑΣΗ ΣΤΟ ∆ΙΑ∆ΙΚΤΥΟ 
 
Κοινές µέθοδοι πρόσβασης στο ∆ιαδίκτυο αποτελούν επιλογική και ευρεία ζώνη. 
∆ηµόσιοι χώροι για χρήση ∆ιαδικτύου περιλαµβάνουν βιβλιοθήκες και Internet 
cafes, όπου υπάρχουν διαθέσιµοι Η/Υ µε σύνδεση στο ∆ιαδίκτυο. Υπάρχουν επίσης 
σηµεία πρόσβασης στο ∆ιαδίκτυο σε δηµόσιους χώρους όπως αίθουσες αναµονής 
αεροδροµίων, µερικές φορές µόνο για σύντοµη χρήση ενόσω βρισκόµαστε σε 
αναµονή. Χρησιµοποιούνται διάφοροι όροι, όπως "δηµόσια περίπτερα ∆ιαδικτύου", 
"δηµόσια τερµατικά ∆ιαδικτύου", "ιστο-τηλέφωνα". 
Το Wi-Fi παρέχει ασύρµατη πρόσβαση στο ∆ιαδίκτυο. Hotspot που παρέχουν τέτοια 
πρόσβαση περιλαµβάνουν Wifi-cafes, όπου κάποιος αρκεί να φέρει τις δικές του/της 
ασύρµατες συσκευές όπως φορητό Η/Υ ή PDA. Οι υπηρεσίες αυτές µπορεί να είναι 
δωρεάν σε όλους, είτε δωρεάν µόνο σε πελάτες, είτε επί πληρωµή. Ένα hotspot δεν 
χρειάζεται να περιορίζεται σε ένα συγκεκριµένο περιβάλλον. Ολόκληρες 
πανεπιστηµιουπόλεις και πάρκα έχουν αυτή τη δυνατότητα, ακόµα και ολόκληρες 
περιοχές. Προσπάθειες να συνδεθεί και ο αγροτικός πληθυσµός έχουν οδηγήσει στα 
ασύρµατα κοινοτικά δίκτυα. 
Τα πλεονεκτήµατα κάποιου από την χρήση του δικού του υπολογιστή περιλαµβάνουν 
την δυνατότητα για κατέβασµα και ανέβασµα αρχείων που δεν υπόκεινται σε 
περιορισµούς, την χρήση του αγαπηµένου του περιηγητή (web browser) και των 
ρυθµίσεων αυτού (το µενού των ρυθµίσεων µπορεί να απενεργοποιηθεί σε έναν 
δηµόσιο υπολογιστή) και την ολοκλήρωση των δραστηριοτήτων στο ίντερνετ και 
στον υπολογιστή µε την χρήση των προγραµµάτων και δεδοµένων που εκείνος 
προτίθεται να χρησιµοποιήσει. (Κατά την χρήση δηµόσιου υπολογιστή, κάποιος 
µπορεί να αποθηκεύσει δεδοµένα στη θυρίδα ηλεκτρονικού ταχυδροµείου του. Για τα 
προγράµµατα µπορεί να κάνει το ίδιο, αλλά το µέγεθος της θυρίδας καθώς και άλλοι 
περιορισµοί στον δηµόσιο υπολογιστή µειώνουν τις δυνατότητες για κάποιον να 
τρέξει τα προγράµµατα που επιθυµεί.) 
Χώρες µε πολύ καλή πρόσβαση στο Ίντερνετ περιλαµβάνουν την Νότια Κορέα, όπου 
το 50% του πληθυσµού έχει ευρυζωνική πρόσβαση, την Σουηδία και τις ΗΠΑ. 
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∆ΗΜΙΟΥΡΓΙΑ ΙΣΤΟΣΕΛΙ∆ΩΝ 
(κατασκευή, δηµοσίευση, προώθηση) 

 
 
Στους περισσότερους από τους χρήστες του Ίντερνετ –αν όχι σε όλους– µετά από ένα 
µικρό ή µεγάλο διάστηµα ενασχόλησης µε το διαδίκτυο γεννιέται το ερώτηµα: «Πώς 
µπορώ να φτιάξω κι εγώ ένα website;» 
Συνακόλουθα τίθενται κι άλλες σχετικές απορίες: 
 

 Χρειάζονται ειδικές γνώσεις; 
 Πρέπει να πληρώσω για να δηµοσιεύσω τις σελίδες µου στο ∆ιαδίκτυο; 
 Πού θα βρω υλικό για τον εµπλουτισµό των σελίδων µου; 
 Πώς θα κάνω γνωστή την ύπαρξη του site που δηµιούργησα; κ.λπ. 

 
Παρακάτω  θα λύσουµε όλες αυτές τις απορίες, ώστε κατόπιν ο ενδιαφερόµενος να 
αποφασίσει αν θέλει να προχωρήσει στη δηµιουργία της δικού του δικτυακού τόπου. 
 
Τα θέµατα που εξετάζονται είναι τα εξής: 
 

 Τι είναι η HTML 
 Εύρεση οπτικοακουστικού υλικού 
 Χρήσιµες συµβουλές για την κατασκευή ιστοσελίδων 
 ∆ωρεάν δηµοσίευση ιστοσελίδων  
 Κατοχύρωση domain name και δηµοσίευση ιστοσελίδων επί πληρωµή 
 Μεταφορά αρχείων από τον υπολογιστή στο server (FTP) 
 Προώθηση - διαφήµιση ιστοσελίδων 
 Πώς µπορούν να χρησιµεύσουν όλα αυτά σε ένα καθηγητή Μέσης Εκπαίδευσης 

 
 
 

ΤΙ ΕΙΝΑΙ Η HTML 
 
Το αρκτικόλεξο HTML σηµαίνει HyperText Markup Language (γλώσσα 
χαρακτηρισµού υπερκειµένου). Με απλά λόγια είναι η γλώσσα που χρησιµοποιείται 
για την περιγραφή της εµφάνισης των ιστοσελίδων. Θα πρέπει να τονίσουµε εξαρχής 
ότι –αν και µοιάζει– δεν είναι µία γλώσσα προγραµµατισµού. 
 
Κάθε ιστοσελίδα που βλέπετε στο ∆ιαδίκτυο είναι γραµµένη σε HTML. Ο browser 
που χρησιµοποιείτε "διαβάζει" τον κώδικα HTML και αναλόγως εµφανίζει το κείµενο 
και τα γραφικά της σελίδας.  
 
Αν θέλετε να δείτε πώς µοιάζει ο κώδικας HTML, ανοίξτε µία οποιαδήποτε 
ιστοσελίδα και επιλέξτε "Προέλευση" από το µενού "Προβολή" του Internet 
Explorer. 
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Παράδειγµα: το παρακάτω τµήµα κώδικα HTML  
 
 
<b><font color="#999900"><big>Καλωσήλθατε στην ιστοσελίδα µου 
</big></font></b><br> <i>Ελπίζω ότι θα βρείτε το περιεχόµενό της ενδιαφέρον</i> 
 
θα έχει ως αποτέλεσµα να εµφανιστεί το κείµενο σε ένα web browser ως εξής: 
 
Καλωσήλθατε στην ιστοσελίδα µου 
Ελπίζω ότι θα βρείτε το περιεχόµενό της ενδιαφέρον 
 
 
Αν λοιπόν γνωρίζει κάποιος HTML, απλώς γράφει τον κώδικα σε έναν επεξεργαστή 
κειµένου και αποθηκεύει το αρχείο µε κατάληξη .html. Ακολούθως βλέπει το 
αποτέλεσµα της εργασίας του ανοίγοντας το αρχείο µε έναν browser. 
Όµως, σήµερα πια κανείς δεν δηµιουργεί ιστοσελίδες γράφοντας κώδικα –µε 
εξαίρεση κάποιους πεισµατάρηδες που αγαπούν το δύσκολο τρόπο. Κι αυτό γιατί 
υπάρχουν τα προγράµµατα κατασκευής ιστοσελίδων, µε τα οποία ο χρήστης µπορεί 
να γράφει και να µορφοποιεί το κείµενο, να προσθέτει εικόνες, να επιλέγει φόντο 
κ.λπ. µέσα από ένα εύχρηστο γραφικό περιβάλλον και να βλέπει αµέσως αυτό που 
δηµιούργησε. 
Αν θέλετε να δηµιουργήσετε ιστοσελίδες, η πρώτη σας δουλειά είναι να 
εγκαταστήσετε ένα σχετικό πρόγραµµα και να µάθετε να το χειρίζεστε (τα 
περισσότερα είναι εύχρηστα). Τέτοια προγράµµατα είναι τα: Netscape Composer, 
Microsoft FrontPage, Macromedia Dreamweaver, CoffeeCup, WebDwarf, HotDog 
κ.ά.  
 
Παρά την ύπαρξη των προγραµµάτων κατασκευής ιστοσελίδων η γνώση της HTML 
δεν είναι περιττή για τους εξής λόγους: 
 
α. ∆ίνει τη δυνατότητα πιο αποτελεσµατικής αντιµετώπισης δυσλειτουργιών (που 

µπορεί να οφείλονται σε διάφορους λόγους) και γενικά επιτρέπει καλύτερο έλεγχο 
πάνω στον ιστοχώρο. 

 
β. Πολλά προγράµµατα κατασκευής ιστοσελίδων δεν υποστηρίζουν πλήρως όλες τις 

δυνατότητες της HTML. Για παράδειγµα το Netscape Composer δεν δηµιουργεί 
σελίδες σε πλαίσια (frames) ή φόρµες δίνει όµως τη δυνατότητα στο χρήστη να 
γράψει και να ενσωµατώσει κώδικα HTML. 

 
γ. Πολλές φορές ο χρήστης βλέποντας διάφορα εφέ και κόλπα σε άλλες σελίδες, θέλει 

να τα µιµηθεί στις δικές του σελίδες. Για να το κάνει αυτό πρέπει να αντιγράψει 
τον κώδικα HTML. 

 
Εποµένως δεν θα ήταν καθόλου περιττό (χωρίς να είναι απαραίτητο), πριν 
καταπιαστείτε µε τη δηµιουργία ιστοσελίδων, να αποκτήσετε βασικές έστω γνώσεις 
της HTML. Για το σκοπό αυτό κυκλοφορούν πολλά βιβλία αλλά και στον Παγκόσµιο 
Ιστό µπορείτε να βρείτε οδηγούς εκµάθησης. Ενδεικτικά αναφέρουµε: 
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Βιβλία 
⇒ Lemay Laura, Πλήρες εγχειρίδιο της HTML 4, Γκιούρδας (1162 σελίδες) 
⇒ Γαλλής, Άγγελος, Προγραµµατίστε σε HTML, ANUBIS (151 σελίδες) 
⇒ Heslop Brent – Budnick Larry, Η HTML στην πράξη, ANUBIS (394 σελίδες) 
⇒ Holzschlag Molly, Οδηγός της HTML 4. Σαφής συνοπτικός οδηγός, Γκιούρδας, 

(260 σελίδες) 
 
 
∆ικτυακοί τόποι 
⇒ “So, you want to make a Web Page!” by Joe Barta  

http://www.pagetutor.com/pagetutor/makapage/index.html  
⇒ HTML Tutorials by John C. Gilson 

http://www.htmltutorials.ca/  
⇒ The HTML Pit Stop 

http://www.pageresource.com/html/index.html 
 
 

ΠΡΟΓΡΑΜΜΑΤΑ ΚΑΤΑΣΚΕΥΗΣ ΙΣΤΟΣΕΛΙ∆ΩΝ 
 

Ένα πολύ εύχρηστο πρόγραµµα κατασκευής ιστοσελίδων είναι το Netscape 
Composer. Περιλαµβάνεται στο Netscape που είναι ένα πλήρες πακέτο 
προγραµµάτων για όλες σχεδόν τις λειτουργίες του Internet (netsurfing, κατασκευή 
ιστοσελίδων, e-mail κλπ). Το Netscape ήταν ένας από τους πρώτους web browsers 
που σήµερα πια έχει σχεδόν εξαφανιστεί λόγω της επικράτησης του Internet Explorer. 
Μπορείτε πάντως να το βρείτε δωρεάν σε CDs των περιοδικών πληροφορικής ή να το 
κατεβάσετε από τo site της Netscape. Αν το χρησιµοποιήσετε, µην παραλείψετε να 
βλέπετε τα αποτελέσµατα και στον Internet Explorer κι όχι µόνο στον browser του 
Netscape γιατί µπορεί να υπάρχουν διαφορές. Και σίγουρα σας ενδιαφέρει πώς 
φαίνεται η σελίδα σας στον Explorer γιατί αυτόν χρησιµοποιεί η συντριπτική 
λειοψηφία των χρηστών του Ιντερνετ. π

 
Πάντως το πιο γνωστό από τα προγράµµατα κατασκευής ιστοσελίδων είναι το 
FrontPage της Microsoft. Φυσικά είναι το πιο διαδεδοµένο όχι επειδή είναι το 
καλύτερο αλλά επειδή είναι προϊόν της Microsoft (http://www.microsoft.com). Το 
καλύτερο από τα εµπορικά πακέτα για τους περισσότερους χρήστες θεωρείτε ότι είναι 
το Dreamweaver της Macromedia. ∆ιαθέτει όλες σχεδόν τις δυνατότητες που 
χρειάζεται ένας χρήστης από τον αρχάριο µέχρι τον πιο προχωρηµένο (περισσότερες 
ληροφορίες: π http://www.macromedia.com)  

 
Άλλα προγράµµατα κατασκευής ιστοσελίδων: 
CoffeeCup (shareware) http://www.coffeecup.com/ 
WebDwarf (freeware) http://www.webdwarf.com/ 

otDog (shareware) H http://www.sausagetools.com/ 
 
 

ΕΥΡΕΣΗ ΟΠΤΙΚΟΑΚΟΥΣΤΙΚΟΥ ΥΛΙΚΟΥ 
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Κατά την κατασκευή ιστοσελίδων, σίγουρα θα χρειαστείτε γραφικά όπως: φόντα, 
µπάρες, κουµπιά, εικονίδια, βελάκια κ.ο.κ. Αν δεν έχετε τη δυνατότητα να τα 
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κατασκευάσετε µόνος σας µε κάποιο σχεδιαστικό πρόγραµµα ή πρόγραµµα 
επεξεργασίας φωτογραφίας, µπορείτε να βρείτε άφθονο υλικό στον Παγκόσµιο Ιστό. 
Οι σχετικές ιστοσελίδες είναι πάρα πολλές, γι’ αυτό και δεν υπάρχει λόγος να 
παραθέσουµε ένα κατάλογο διευθύνσεων. Απλά κάντε µία αναζήτηση σε 
οποιαδήποτε µηχανή µε όρους: “free web graphics”, “free icons” “free clipart” (µε τα 
εισαγωγικά) και θα έχετε τη δυνατότητα επιλογής από εκατοντάδες διευθύνσεις.  
 
Αν πάλι χρειάζεστε άλλο οπτικοακουστικό υλικό (φωτογραφίες, ήχους, βίντεο), 
µπορείτε να το αναζητήσετε από τις γνωστές µηχανές αναζήτησης που διαθέτουν 
ειδικές σελίδες για αναζήτηση πολυµέσων:  
Google http://www.google.com.gr 
AltaVista http://www.altavista.com 
Lycos http://www.lycos.com 
 
Υπάρχουν όµως και πολλές µηχανές αναζήτησης που είναι εξειδικευµένες στην 
αναζήτηση πολυµέσων, όπως οι παρακάτω: 
Alltheweb  
http://www.alltheweb.com/ (όλα τα είδη πολυµέσων) 
Ditto  
http://www.ditto.com/ (εικόνες) 
Singingfish  
http://www.singingfish.com/ (αρχεία ήχου και βίντεο) 
The Amazing Picture Machine  
http://www.ncrtec.org/picture.htm (εικόνες) 
Yahoo! Picture Gallery  
http://search.gallery.yahoo.com (εικόνες) 
Image Finder  
http://sunsite.berkeley.edu/ImageFinder/ (εικόνες) 
Webseek at Columbia University  
http://www.ctr.columbia.edu/webseek/ (εικόνες και βίντεο) 
 

 
ΧΡΗΣΙΜΕΣ ΣΥΜΒΟΥΛΕΣ ΓΙΑ ΤΗΝ 

ΚΑΤΑΣΚΕΥΗ ΙΣΤΟΣΕΛΙ∆ΩΝ 
 
Η καλή γνώση ενός προγράµµατος δηµιουργίας ιστοσελίδων δεν αρκεί για την 
κατασκευή ενός καλού web site. Κι όταν λέµε «καλό website» δεν εννοούµε µόνο το 
ωραίο αλλά κυρίως το λειτουργικό. ∆ηλαδή ένα website που δεν ταλαιπωρεί τον 
επισκέπτη κατά την περιήγησή του σ' αυτό. Κατά την κατασκευή των σελίδων σας 
λάβετε σοβαρά υπόψη το παρακάτω απάνθισµα συµβουλών των επαγγελµατιών 
σχεδιαστών ιστοσελίδων: 
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1. Να θυµάστε πάντα ότι το αντικείµενο της εργασίας σας δεν θα τυπωθεί αλλά 
θα εµφανιστεί σε µία οθόνη. Αυτό σηµαίνει ότι ο αποδέκτης θα περιµένει 
κάποιο µικρό ή µεγάλο χρονικό διάστηµα για να εµφανιστεί η σελίδα στον 
υπολογιστή του. Εκτός από την εµφάνιση και το περιεχόµενο πρέπει πάντα να 
λαµβάνετε σοβαρά υπόψη και το µέγεθος των αρχείων που δηµιουργείτε. 
Αυτό δεν δείχνει µόνο σεβασµό στο χρόνο του επισκέπτη αλλά είναι και 
χρήσιµο για σας. Οι «κυβερνοταξιδιώτες» δεν φηµίζονται για την υποµονή 
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τους: αν µία σελίδα αργεί να «κατέβει» πέρα από ένα εύλογο χρονικό 
διάστηµα, φεύγουν από το συγκεκριµένο δικτυακό τόπο. Το άθροισµα των 
αρχείων της πρώτης σελίδας (γραφικά και html αρχείο) πρέπει να φτάνει το 
πολύ 100 Κbs και οι «µέσα» σελίδες λιγότερο. Όταν ένας σύνδεσµος 
παραπέµπει σε αρχείο µεγάλου µεγέθους (αρχείο εικόνας, ήχου, βίντεο κλπ), 
πληροφορήστε τον επισκέπτη για το πόσα Kbs είναι αυτό το αρχείο. 

2. Τα πολλά γραφικά και τα εφέ δεν κάνουν αναγκαστικά όµορφη τη σελίδα. 
ενδέχεται να την κάνουν ακαλαίσθητη και κακόγουστη. Χρησιµοποιήστε τα 
όταν και όσα χρειάζονται για να γίνει η σελίδα όµορφη. Υπάρχουν πολύ 
όµορφες λιτές σελίδες και άσχηµες σελίδες γεµάτες χρώµατα και γραφικά. 
Μην εκβιάζετε την προσοχή των επισκεπτών. Αν φτιάχνετε σελίδες µόνο για 
να δηµοσιεύσετε κάποιες συγκεκριµένες πληροφορίες (π.χ. µία επιστηµονική 
διατριβή) τα πολλά γραφικά περιττεύουν. Γενικά ο κατασκευαστής 
ιστοσελίδων πρέπει να αναζητά τη χρυσή τοµή µεταξύ της φτωχής και της 
πληθωρικής ιστοσελίδας. 

3. Μην γράφετε τεράστια κείµενα. Η ανάγνωση στην οθόνη είναι πολύ πιο 
κουραστική από την ανάγνωση του εντύπου. Αντί να κάνετε µία τεράστια 
σελίδα, κάντε µερικές µικρότερες χωρίζοντας το κείµενο σε αυτόνοµες 
ενότητες µε βάση το περιεχόµενο. Να είστε πάντοτε σαφής και σύντοµος. Αν 
πάλι το µεγάλο κείµενο είναι αναπόφευκτο, δώστε στον επισκέπτη τη 
δυνατότητα να το κατεβάσει στον υπολογιστή του µε τη µορφή αρχείου doc 
(Word) ή pdf (Acrobat) ούτως ώστε να το διαβάσει off-line. 

4. Μην κάνετε το site σας λαβύρινθο. Προσπαθήστε να είναι άνετη η περιήγηση 
του επισκέπτη δηµιουργώντας συνδέσµους για να µετακινείται από τη µία 
σελίδα στις άλλες και να βρίσκει αυτό που θέλει από το σηµείο όπου 
βρίσκεται χωρίς να χρειάζεται να επιστρέφει στην πρώτη ή σε κάποια άλλη 
σελίδα. Το ιδανικό –λένε οι επαγγελµατίες– είναι από οποιοδήποτε σηµείο του 
site να µπορεί να µετακινηθεί σε οποιοδήποτε άλλο µε όχι περισσότερα από 3 
κλικ. 

5. Μη χρησιµοποιείτε µεγάλο µέγεθος γραµµατοσειράς εκεί που θέλετε να 
δώσετε έµφαση. Το µεγάλο µέγεθος γραµµατοσειράς αντιστοιχεί στη δυνατή 
φωνή της προφορικής οµιλίας.  

6. Χρησιµοποιείτε µε µεγάλη φειδώ τα κινούµενα σκίτσα (animated gif). Είναι 
χαριτωµένα και ελκυστικά, αλλά η υπερβολή στη χρήση τους µπορεί να δώσει 
µία όψη «λούνα παρκ» σε µία ιστοσελίδα.  

7. Αποφύγετε το εφέ blinking που κάνει το κείµενο να αναβοσβήνει. Είναι ένα 
εφέ που τραβά σχεδόν µε τη βία την προσοχή του αναγνώστη και την κρατά 
ακόµη κι όταν έχει διαβάσει τις σχετικές πληροφορίες. Χρησιµοποιήστε το 
µόνο όταν πιστεύετε ότι ο επισκέπτης πρέπει οπωσδήποτε να προσέξει ένα 
σηµείο κι όχι για ψύλλου πήδηµα. Και µόνο σε µία ή δύο λέξεις, όχι σε 
ολόκληρη πρόταση. 

8. Ποτέ µη βάζετε ανοιχτόχρωµα γράµµατα σε ανοιχτόχρωµο φόντο και σκούρα 
γράµµατα σε σκούρο φόντο, εκτός αν έχετε λόγους να βλάψετε την όραση των 
επισκεπτών σας. 

9. Μην δηµιουργείτε συνδέσµους που ανοίγουν σε νέο παράθυρο και µη 
φορτώνετε αυτόµατα νέα παράθυρα κατά το άνοιγµα µιας σελίδας. Κανείς δεν 
θέλει να ανοίγουν ανεπιθύµητα παράθυρα στην οθόνη του. Χρησιµοποιήστε 
την τεχνική αυτή µόνο όταν ο σύνδεσµος παραπέµπει σε µία ξένη ιστοσελίδα. 
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10. Όταν είναι απαραίτητο, δώστε τεχνικές οδηγίες στους επισκέπτες σας, π.χ. 
όταν πρέπει να κατεβάσουν κάποιο αρχείο που απαιτεί ειδικό πρόγραµµα, 
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δώστε τους τη δυνατότητα να κατεβάσουν το πρόγραµµα αυτό ή παραπέµψτε 
τους στη σελίδα της κατασκευάστριας εταιρίας. Οι τεχνικές οδηγίες που τυχόν 
θα προσθέσετε στις σελίδες σας θα πρέπει να είναι κατανοητές και σύντοµες. 
Μην υποθέτετε ότι χρησιµοποιούν όλοι τα προγράµµατα που χρησιµοποιείτε 
εσείς, αλλά λάβετε υπόψη σας όλες τις πιθανές περιπτώσεις. 

 
 

 
∆ΩΡΕΑΝ ∆ΗΜΟΣΙΕΥΣΗ ΙΣΤΟΣΕΛΙ∆ΩΝ ΣΤΟΝ 

ΠΑΓΚΟΣΜΙΟ ΙΣΤΟ 
 
Όποιος θέλει να δηµοσιεύσει στον Παγκόσµιο Ιστό µία προσωπική ιστοσελίδα µπορεί 
να το κάνει δωρεάν χρησιµοποιώντας τις υπηρεσίες µιας από τις πάµπολλες εταιρείες 
παροχής δωρεάν φιλοξενίας ιστοσελίδων. Αυτές οι εταιρείες, εκτός από τον χώρο, 
δίνουν και δωρεάν e-mail αλλά και άλλες παροχές (γραφικά, οδηγούς κατασκευής 
ιστοσελίδων κ.ά.). Για ένα αναλυτικό κατάλογο τέτοιων εταιρειών επισκεφθείτε το 
Free Web Space Finder (http://www.free-web-space-finder.com).   
Ενδεικτικά αναφέρουµε µερικές από αυτές: 
Freeservers http://www.freeservers.com/  
Fate Back http://www.fateback.com/  
Angelfire http://www.angelfire.lycos.com/ 
50megs http://www.50megs.com/  
 
Φιλοξενία ιστοσελίδων παρέχουν στα µέλη τους και οι γνωστές ελληνικές πύλες όπως 
το In και το Pathfinder. 
 
Το βασικό πλεονέκτηµα της δηµοσίευσης ιστοσελίδων σε δωρεάν παρεχόµενο χώρο 
είναι η απουσία κόστους. Ωστόσο τα µειονεκτήµατα δεν είναι λίγα: 

 
1. Τα έσοδα των εταιρειών που παρέχουν δωρεάν χώρο για φιλοξενία ιστοσελίδων 

προέρχονται από τις διαφηµίσεις. Αυτό σηµαίνει ότι κάθε ιδιοκτήτης 
φιλοξενούµενης ιστοσελίδας υποχρεούται να τοποθετήσει στο site του ένα 
διαφηµιστικό πλαίσιο ή αυτό το πλαίσιο φορτώνεται αυτόµατα σε νέο παράθυρο 
µαζί µε τη σελίδα του. Η διαφήµιση αυτή είναι συνήθως ενοχλητική αισθητικά 
και επιβαρύνει την ταχύτητα πρόσβασης. 

 
2. Η διεύθυνση ενός site που φιλοξενείται δωρεάν καθορίζεται από την εταιρία και 

συνήθως είναι του τύπου: http://www.company.com/~username ή 
http://members.company.com/~username ή κάτι ανάλογο. Αντίθετα, µε την 
κατοχύρωση ενός ονόµατος περιοχής ο χρήστης διαλέγει το όνοµα (εάν φυσικά 
δεν το χρησιµοποιεί άλλος) και η διεύθυνσή του είναι απλή και µπορεί εύκολα να 
αποµνηµονευθεί από τους επισκέπτες (του τύπου: http://www.username.com).  
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3. Οι εταιρίες που προσφέρουν φιλοξενία απαγορεύουν την εκµετάλλευσή τους από 
τους ιδιοκτήτες, οι οποίοι ούτε διαφηµίσεις µπορούν να τοποθετήσουν ούτε να 
χρησιµοποιήσουν τις ιστοσελίδες τους για την πώληση προϊόντων – υπηρεσιών. 
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4. Ο χώρος που συνήθως προσφέρεται αρκεί για ένα απλό προσωπικό site όχι όµως 
για µεγαλύτερες απαιτήσεις. Επιπλέον κάποιες εταιρείες απαγορεύουν στα 
φιλοξενούµενα site να περιέχουν κάποιους τύπους αρχείων (mp3, exe κ.ά.). 

 
5. Σήµερα πια το κόστος για να δηµοσιεύσει κάποιος ιστοσελίδες σε δικό του 

domain είναι πολύ προσιτό (ξεκινά από λιγότερα των 100 € ετησίως). Με αυτά τα 
χρήµατα αποκτά κανείς ένα πολύ σηµαντικό σε µέγεθος χώρο, πολλαπλές 
ηλεκτρονικές διευθύνσεις και πολλές άλλες παροχές. 

 
6. Το κυριότερο µειονέκτηµα είναι ότι εάν κάποτε η εταιρεία κλείσει ή πάψει να 

ενδιαφέρεται για τη φιλοξενία ιστοσελίδων το site πρέπει να κλείσει ή να 
«µετακοµίσει» σε άλλη διεύθυνση. Αυτό σηµαίνει ότι θα χαθεί για κάποιους από 
τους µόνιµους επισκέπτες, ενώ θα πρέπει να ενηµερωθούν όλα τα εργαλεία 
αναζήτησης καθώς και οι κατάλογοι που το έχουν καταχωρήσει.  

 
 

 
ΚΑΤΟΧΥΡΩΣΗ ΟΝΟΜΑΣΙΑΣ ΠΕΡΙΟΧΗΣ 

(DOMAIN NAME) 
ΚΑΙ ∆ΗΜΟΣΙΕΥΣΗ ΙΣΤΟΣΕΛΙ∆ΩΝ ΕΠΙ ΠΛΗΡΩΜΗ 

 
Το Ίδρυµα Τεχνολογίας και Έρευνας (I.T.E.) που εδρεύει στο Ηράκλειο είναι ο 
αρµόδιος φορέας για τη διαχείριση των ονοµάτων περιοχής του ελληνικού Ιστού, 
δηλαδή αυτών που έχουν την κατάληξη .gr (όπως και .com.gr, edu.gr, org.gr κλπ)  
 
Στη διεύθυνση http://www.gr µπορείτε να δείτε αν είναι διαθέσιµο το όνοµα που σας 
ενδιαφέρει και, αν είναι ελεύθερο, να το κατοχυρώσετε. Από την στιγµή που κάποιος 
κατοχυρώσει το όνοµα που τον ενδιαφέρει, υποχρεούται να το ενεργοποιήσει µέσα σε 
κάποιο συγκεκριµένο διάστηµα αλλιώς µπορεί να παραχωρηθεί σε άλλο 
ενδιαφερόµενο. Όλους τους όρους και τις υποχρεώσεις που απορρέουν από την 
κατοχύρωση ενός ονόµατος περιοχής µπορείτε να τους διαβάσετε στην παραπάνω 
διεύθυνση. 
 
Η ανανέωση της κατοχύρωσης γίνεται κάθε δύο χρόνια. Το χρηµατικό αντίτιµο είναι 
51,94 € για τα δύο πρώτα χρόνια και 34,6 € για κάθε δύο από τα επόµενα χρόνια.   
 
Προσοχή! Με την παραπάνω διαδικασία και εφόσον καταβάλετε το αντίτιµο, 
αποκτάτε απλά το δικαίωµα χρήσης ενός ονόµατος περιοχής του ελληνικού Ιστού 
(τύπου www.myname.gr). Αυτό δεν σηµαίνει ότι αποκτάτε και χώρο για φιλοξενία 
ιστοσελίδων. Θα πρέπει να απευθυνθείτε σε κάποια εταιρεία φιλοξενίας ιστοσελίδων, 
η οποία θα αναλάβει να δηµοσιεύσει τις ιστοσελίδες σας στους υπολογιστές της 
(servers για την ακρίβεια) ώστε να είναι προσβάσιµες πάντα. Οι τιµές για τη 
φιλοξενία ιστοσελίδων είναι αρκετά προσιτές και η διακύµανσή τους είναι ανάλογη 
µε τις παροχές του “πακέτου” που θα επιλέξετε. Μπορείτε να βρείτε αρκετά 
ικανοποιητικά προγράµµατα µε λιγότερα από 100 € το χρόνο. Πολλές φορές στην 
τιµή περιλαµβάνεται και το αντίτιµο για την κατοχύρωση του ονόµατος περιοχής 
(δηλαδή τα χρήµατα που θα δοθούν στο Ι.Τ.Ε.) και σ’ αυτή την περίπτωση η εταιρεία 
αναλαµβάνει για λογαριασµό σας τη σχετική διαδικασία. 
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Παραθέτουµε ενδεικτικά µερικές διευθύνσεις ελληνικών εταιρειών που παρέχουν 
φιλοξενία ιστοσελίδων: 
 
http://www.ip.gr                                  http://www.positron.gr 
http://www.internetservices.gr            http://www.privenet.gr         
http://www.arx.gr                                http://www.thesuperweb.gr 
http://www.dnhost.gr                          http://www.global.gr  
 
 
ΜΕΤΑΦΟΡΑ ΑΡΧΕΙΩΝ ΑΠΟ ΤΟΝ ΥΠΟΛΟΓΙΣΤΗ ΣΤΟ 

SERVER (FTP) 
 

To FTP (File Transfer Protocol = Πρωτόκολλο µεταφοράς αρχείων) είναι το 
πρωτόκολλο που χρησιµοποιείται στο ∆ιαδίκτυο για τη µεταφορά και διακίνηση 
αρχείων µεταξύ υπολογιστών.  
 
Για να το καταλάβετε καλύτερα πρέπει να το αντιδιαστείλετε από το HTTP 
(HyperText Transfer Protocol = Πρωτόκολλο µεταφοράς υπερκειµένου).              
Όταν γράφουµε στη γραµµή Location ενός Browser: 
http://www.company.com/products/index.html και πατάµε το enter ουσιαστικά 
δίνουµε στον υπολογιστή µας την εξής εντολή: «Στον Παγκόσµιο Ιστό και µε βάση το 
πρωτόκολλο http, πραγµατοποίησε σύνδεση µε τον server που έχει την επωνυµία 
company.com, µπες στον κατάλογο products, βρες και εµφάνισε στην οθόνη το 
αρχείο index.html.». Αυτή είναι η σύνδεση µέσω http. Όταν όµως συνδεόµαστε µέσω 
ftp δίνουµε την εντολή στον υπολογιστή να µας παρουσιάσει τα περιεχόµενα ενός 
καταλόγου που βρίσκεται στο σκληρό δίσκο ενός αποµακρυσµένου υπολογιστή όπως 
περίπου βλέπουµε τα περιεχόµενα των καταλόγων του σκληρού δίσκου του 
υπολογιστή µας. Από κει κι έπειτα µπορούµε (ανάλογα µε το είδος της πρόσβασης) 
να κατεβάσουµε, να στείλουµε, να διαγράψουµε, να µετακινήσουµε και γενικώς να 
διαχειριστούµε τα αρχεία του καταλόγου του αποµακρυσµένου υπολογιστή. 
 
Όταν κάποια εταιρεία σας δίνει χώρο για φιλοξενία ιστοσελίδων (δωρεάν ή επί 
πληρωµή) σας παραχωρεί το δικαίωµα πρόσβασης σε ένα µέρος του σκληρού δίσκου 
του server της. Εκεί θα έχετε πρόσβαση µέσω ftp µόνο εσείς για να αποστείλετε όλα 
τα αρχεία που απαιτούνται για το site σας (ιστοσελίδες και γραφικά). Κατόπιν 
χρησιµοποιώντας το όνοµα χρήστη και τον κωδικό πρόσβασης που θα σας δοθεί 
µπορείτε να διαχειρίζεστε τα αρχεία που θα αποτελούν το site σας.  
 
Η σύνδεση µε τον αποµακρυσµένο υπολογιστή για τη µεταφορά αρχείων γίνεται µε 
ένα ειδικό πρόγραµµα. Τέτοια είναι τα: WSFTP, CoreFTP, LeechFTP, FTP Surfer, 
FileZilla κ.ά. που µπορείτε να κατεβάσετε δωρεάν από το site της Cnet 
(http://www.download.com) 
 
Επισηµαίνουµε τέλος ότι πολλές από τις εταιρείες παροχής φιλοξενίας δίνουν τη 
δυνατότητα στους «φιλοξενούµενους» να στέλνουν τα αρχεία τους µέσα από ειδικές 
σελίδες µε φόρµες, χωρίς να απαιτείται η χρήση κάποιου προγράµµατος FTP. 
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ΠΡΟΩΘΗΣΗ - ∆ΙΑΦΗΜΙΣΗ ΙΣΤΟΣΕΛΙ∆ΩΝ 

 
Αν ο τηλεφωνικός κατάλογος δεν περιλάµβανε τον αριθµό του τηλεφώνου σας και 
εσείς δεν τον δίνατε σε κανέναν, είναι σίγουρο ότι µόνο κατά λάθος θα σας 
τηλεφωνούσε κάποιος. Το ίδιο συµβαίνει και µε τις ιστοσελίδες. Κανείς δεν θα 
επισκεφθεί το site σας, αν δεν φροντίσετε να γνωστοποιήσετε την ύπαρξή του. 
 
Αν το site σας έχει εµπορικό σκοπό, πρέπει να διαθέσετε ένα ποσό για τη διαφήµισή 
του σε έντυπα ή στον Παγκόσµιο Ιστό. Υπάρχουν όµως και τρόποι για δωρεάν 
προώθηση ιστοσελίδων. 
 

1. Το πρώτο και κύριο που πρέπει οπωσδήποτε να κάνετε είναι να δηλώσετε την 
ιστοσελίδα σας σε όσους καταλόγους, µηχανές αναζήτησης, πύλες (ελληνικές 
και ξένες) γνωρίζετε. Όλες έχουν κάποιο σχετικό σύνδεσµο και κάποια φόρµα 
γι’ αυτή την ενέργεια. 

2. Στείλτε επιστολές στους υπευθύνους «συγγενικών» σελίδων και ενηµερώστε 
τους για την ύπαρξη της ιστοσελίδας σας παρακαλώντας τους να 
τοποθετήσουν στη σελίδα τους ένα σύνδεσµο προς τη δική σας.  

3. ∆ηµιουργήστε και εσείς µία σελίδα µε διευθύνσεις σελίδων που έχουν 
περιεχόµενο σχετικό µε τη δική σας. Πολλοί χρήστες θα επισκέπτονται τη 
σελίδα σας για να τη χρησιµοποιήσουν ως σηµείο εκκίνησης για σχετικές 
αναζητήσεις. 

4. Στείλτε ενηµερωτικές επιστολές σε παραλήπτες που πιστεύετε ότι 
ενδιαφέρονται για αυτά που δηµοσιεύετε. Μη στέλνετε άκριτα επιστολές σε 
οποιουσδήποτε, εφόσον γνωρίζετε πόσο ενοχλητική είναι η ανεπιθύµητη 
αλληλογραφία. Επίσης σκόπιµο είναι στους αποδέκτες σας να συµπεριλάβετε 
υπευθύνους περιοδικών για το Ίντερνετ ή περιοδικών µε ειδικό περιεχόµενο 
σχετικό µε αυτό των ιστοσελίδων σας. 

5. Γράψτε ανακοινώσεις σε φόρα και πίνακες ανακοινώσεων για να 
γνωστοποιήσετε την ύπαρξη του site σας. Και πάλι θα πρέπει το περιεχόµενο 
των χώρων αυτών να είναι σχετικό για να µην γίνεστε άσκοπα ενοχλητικοί. 

6. ∆ηµιουργήστε µία φόρµα στην οποία οι επισκέπτες θα µπορούν να δηλώνουν 
το e-mail τους για να τους ενηµερώνετε κάθε φορά που προσθέτετε υλικό. 
Αυτό θα αποτελεί µία συνεχή υπενθύµιση στους ενδιαφεροµένους για την 
ύπαρξη και λειτουργία του ιστοχώρου σας. 

7. Ενσωµατώστε µία signature στις ηλεκτρονικές επιστολές σας. Αυτό είναι µία 
µικρή φράση όπως «Επισκεφθείτε το site µου στη διεύθυνση 
http://www.mysite.com», η οποία θα προστίθεται αυτόµατα στο τέλος κάθε e-
mail που αποστέλλετε. 
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8. Εγγραφείτε σε κάποια υπηρεσία «ανταλλαγής banners». Μετά υποχρεούστε 
να έχετε ένα πλαίσιο στην ιστοσελίδα σας όπου θα εµφανίζονται 
εναλλασσόµενες διαφηµίσεις των σελίδων που συµµετέχουν στο πρόγραµµα 
(µέσα σ’ αυτές και της δικής σας). Φυσικά ανάλογα banners θα υπάρχουν και 
στις άλλες σελίδες που συµµετέχουν στο πρόγραµµα. Κατ’ αυτόν τον τρόπο η 
σελίδα σας θα διαφηµίζεται δωρεάν µέσα από άλλες.  
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ΠΩΣ ΧΡΗΣΙΜΕΥΟΥΝ ΟΛΑ ΑΥΤΑ 

ΣΕ ΕΝΑΝ ΕΚΠΑΙ∆ΕΥΤΗ  
 
Τα τελευταία χρόνια έχει αναδειχθεί επαρκώς η χρησιµότητα του διαδικτύου στην 
εκπαιδευτική πράξη. Περισσότερα ο ενδιαφερόµενος µπορεί να αναζητήσει σε 
σχετικές ιστοσελίδες και δηµοσιεύµατα του Τύπου. Εδώ µας απασχολεί ειδικά η 
χρησιµότητα της ενασχόλησης του εκπαιδευτή µε την κατασκευή ιστοσελίδων. Γιατί 
δηλαδή είναι χρήσιµο για τον εκπαιδευτή όχι απλά να χρησιµοποιεί το διαδίκτυο στην 
διδασκαλία, αλλά να µπορεί να δηµιουργεί τις δικές του ιστοσελίδες; Με την 
κατασκευή ιστοσελίδων λοιπόν ο κάθε εκπαιδευτής έχει τη δυνατότητα… 
 

1. Να εκθέσει τη δουλειά του, να εκφράσει δηµόσια την άποψή του σε θέµατα 
της εργασίας του, να έρθει σε επαφή µε συναδέλφους του, να µοιραστεί τους 
προβληµατισµούς του κ.λπ. 

 
2. Να δηµοσιεύσει επιπλέον ενηµερωτικό υλικό για τους ενδιαφερόµενους 

µαθητές. Εξυπακούεται πως ότι χρειάζεται να ξέρουν οι µαθητές αποτελεί 
αντικείµενο διδασκαλίας µέσα στην τάξη. Στον Παγκόσµιο Ιστό όµως, µπορεί 
να δηµοσιεύσει επιπλέον υλικό που δεν «χωρά» στα πλαίσια της διδακτικής 
ώρας. ∆ηλαδή όχι µόνο να προτείνει ιστοσελίδες ή να προτρέψει τους µαθητές 
να αναζητήσουν το σχετικό υλικό, αλλά να τους προσφέρει ο ίδιος το υλικό 
που κρίνει ότι πρέπει να δουν. Μερικά παραδείγµατα: 
o µε αφορµή τη διδασκαλία ενός ποιήµατος να δώσει στους µαθητές που 

ενδιαφέρονται τη δυνατότητα να διαβάσουν στην ιστοσελίδα του κι άλλα 
ποιήµατα του ίδιου ποιητή ώστε να γνωρίσουν καλύτερα το έργο του. 

o στο µάθηµα της Ιστορίας να δηµοσιεύσει επιπλέον υλικό που δεν υπάρχει  
στο βιβλίο (επιπλέον φωτογραφίες ή πληροφορίες) ή που δεν µπορεί να 
υπάρξει σε ένα βιβλίο (αρχεία ήχου, βίντεο). 

o κατά την περίοδο των εξετάσεων µπορεί να δηµοσιεύσει ενδεικτικά 
θέµατα εξετάσεων ή θέµατα που ζητήθηκαν σε εξετάσεις προηγούµενων 
ετών. 

 
3. Να χρησιµοποιήσει ως µέσο διδασκαλίας τις ιστοσελίδες χωρίς να χρειάζεται 

να ανατρέξει στο Παγκόσµιο Ιστό. Αν η σύνδεση δεν είναι εφικτή, ο 
διδάσκων δηµιουργεί τις ιστοσελίδες που θα τον βοηθήσουν στο µάθηµά του 
και τις περνάει στο σκληρό δίσκο των υπολογιστών του εργαστηρίου. Έτσι οι 
µαθητές έχουν πρόσβαση σ’ αυτές χωρίς να απαιτείται η φιλοξενία τους από 
κάποιο server. 
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4. Να δηµοσιεύσει τις εργασίες των µαθητών του. Αυτό µπορεί να αποτελέσει 
ένα επιπλέον κίνητρο εργασίας γι’ αυτούς. 
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Περιγραφή της Εφαρµογής 
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ΕΠΙΛΕΓΟΝΤΑΣ ΤΗΝ ΕΦΑΡΜΟΓΗ 

 
Υπάρχουν δυο ειδών προγράµµατα για να κατασκευάσετε ένα µενού: τα 
προγράµµατα κατασκευής ιστοσελίδων, από τα οποία µπορείτε να δηµιουργήσετε 
διάφορα µενού που θα χρησιµοποιούνται όµως στην ίδια τη σελίδα και τα 
προγράµµατα κατασκευής µενού που έχουν σχεδιαστεί αποκλειστικά για το σκοπό 
αυτό. Μετά από µια αναζήτηση στο διαδίκτυο µπορεί να βρει κανείς πολλά 
προγράµµατα κατασκευής µενού για ιστοσελίδες. Τα δυο πιο εντυπωσιακά και 
εύχρηστα είναι τα εξής :  το Flash Menu Factory της εταιρίας Epinoisis software 
και το AllWebMenus της Ελληνικής εταιρίας Likno το οποίο και τελικά θα επιλεγεί.    
 
   
Flash Menu Factory: Το Flash Menu Factory είναι µια καινούρια εφαρµογή 
της εταιρίας “Epinoisis software” που σας δίνει τη δυνατότητα να κατασκευάσετε 
χρήσιµα και ταυτόχρονα εντυπωσιακά µενού για δοµήσετε την ιστοσελίδα σας. 
  
 

 
 
 
∆εν προϋποθέτει καθόλου γνώσεις πάνω στο Flash αφού όλα γίνονται αυτόµατα 
χρησιµοποιώντας τα έτοιµα µενού σχεδιασµένα σε Flash που προσφέρει η εφαρµογή. 
∆ηµιουργεί οριζόντια και κάθετα µενού δοµηµένα µε εντυπωσιακές κινούµενες 
εικόνες, ήχο, backgrounds κα. Είναι µικρού κόστους και υποστηρίζεται πλήρως από 
το δικτυακό της τόπο, όπου µπορείτε να προµηθευτείτε δωρεάν το DEMO της 
εφαρµογής.  

http://www.FlashMenuFactory.com 
Παρά τα εντυπωσιακά µενού που δηµιουργεί, έχει κάποια βασικά µειονεκτήµατα. Το 
πιο βασικό είναι ότι τα µενού που δηµιουργεί δεν έχουν απεριόριστο βάθος αλλά 
αναπτύσσονται µόνο σε ένα επίπεδο. Επίσης αρνητικό στοιχείο είναι η µη δυνατότητα 
πρόσθεσης επιπλέων κώδικα Javascript στα στοιχεία του µενού, ώστε να είναι σε 
θέση να εκτελέσουν κάποιες ειδικές λειτουργίες.  
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Παρόλα αυτά όµως η συγκεκριµένη εφαρµογή είναι πολύ καινούρια (αφού βρίσκεται 
στην πρώτη της έκδοση) και µπορεί µε τις απαραίτητες προσθήκες να εξελιχθεί σε 
ένα πλήρες εργαλείο κατασκευής µενού για ιστοσελίδες.  



Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
AllWebMenus: Το Allwebmenus είναι µια πλήρης εφαρµογή κατασκευής 
DHTML/Javascript µενού για την εύκολη πλοήγηση στις ιστοσελίδες, που δεν 
απαιτεί απολύτως καµία προηγούµενη εµπειρία σε HTML ή Javascript. ∆ηµιουργεί 
cross-browser, popup ή drop down menus που λειτουργούν το ίδιο σε όλους τους 
browsers που υποστηρίζουν DHTML (όπως τον Netscape Navigator, Internet 
Explorer, Opera, Mozilla, Konqueror, Safari κ.α). 

 

 
 

Ενα Javascript menu µπορεί να σχεδιαστεί µε µια απλή προσέγγιση σε µορφή 
δέντρου. Μπορείτε έπειτα να το προσαρµόσετε πλήρως  µε τη χρησιµοποίηση των  
ιδιοτήτων µορφοποίησης είτε µε την επιλογή µιας προκαθορισµένης εµφάνισης από 
τη συλλογή της εφαρµογής. Μπορεί να είναι κάθετο ή οριζόντιο, popup ή dropdown, 
να είναι κινητό, να παραµένει ορατό καθώς κυλάει η σελίδα, να περιέχει στατικές ή 
κινούµενες εικόνες, σύνορα, χρώµατα και πολλά άλλα.  
Αφού λοιπόν έχει προσαρµοστεί το µενού µε τις επιλογές σας, µπορείτε να το 
συντάξετε(compile) και να το συνδέσετε(link) µε τις ιστοσελίδες σας εύκολα και 
γρήγορα, χωρίς να χρησιµοποιήσετε καθόλου κώδικα. 
Το Allwebmenus θα σας εξοικονοµήσει σηµαντικό χρόνο και προσπάθεια που 
απαιτούνται για να καταλάβετε την ∆υναµική HTML και  τον κώδικα Javascript µε 
τρόπο τέτοιο ώστε να είναι ικανό να υποστηρίξει όλους DHTML browsers.  
 Το κόστος αγοράς της εφαρµογής είναι πολύ µικρό και στον δικτυακό τόπο της 
διατίθεται δωρεάν το  DEMO του AllWebMenus µε τις πιο χρήσιµες ιδιότητες. 

 
 

http://www.likno.com 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

ΞΕΚΙΝΩΝΤΑΣ ΤΗΝ ΕΦΑΡΜΟΓΗ 
 

 
 

Με το άνοιγµα της εφαρµογής εµφανίζεται το παραπάνω πλαίσιο, που σας 
καλωσορίζει και σας ρωτάει πως θέλετε να ξεκινήσετε. Μπορείτε λοιπόν να 
δηµιουργήσετε µια νέα εργασία κατασκευής µενού (Create a new menu project). 
 
 
 
 
 Η επιλογή αυτή σας παραπέµπει 
σε ένα νέο παράθυρο που 
περιέχει µια συλλογή από έτοιµα 
θέµατα (Theme Gallery). Από 
εδώ επιλέγετε το θέµα πάνω στο 
οποίο επιθυµείτε να βασίζεται το 
σχέδιο του µενού σας. Έχετε να 
επιλέξετε ανάµεσα σε µια 
πληθώρα θεµάτων καθώς και να 
βλέπετε στο διπλανό πλαίσιο την 
προεπισκόπηση τους. Σας δίνετε 
επίσης η δυνατότητα να 
κατεβάσετε περισσότερα 
καινούρια θέµατα (Download 
more Themes) από τον δικτυακό 
τόπο της εφαρµογής: 
http://www.licno.com  
 

 

ΤΕΙ Σερρών – Τµήµα Πληροφορικής & Επικοινωνιών 
 

20



Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
Μπορείτε επίσης να ανοίξετε 
ένα ήδη κατασκευασµένο µενού 
(Open an existing menu project) 
για περεταίρω επεξεργασία.   
 
 
 
 
 
 
Είτε τέλος να ανοίξετε ένα παράδειγµα 
(Open Example) που σας προσφέρει η 
εφαρµογή, το οποίο θα είναι 
βασισµένο στη συλλογή των θεµάτων 
ή σε κάποια άλλα γενικά 
παραδείγµατα. Επιπλέων 
παραδείγµατα είναι διαθέσιµα στην 
ιστοσελίδα του προγράµµατος 
(download examples). 
  
 
 
 
 
 
 
 
 
 
 
Αφού µπείτε λοιπόν στο κύριο παράθυρο της 
εφαρµογής θα παρατηρήσετε στα δεξιά το 
πλαίσιο στο οποίο αναπτύσσεται η δοµή του 
µενού που επεξεργάζεστε. Με τη µορφή 
δένδρου αναπαρίστανται τα όλα τα στοιχεία 
του µενού σας όπως τα αντικείµενα (item) και 
τα υποµενού (submenus).   
  
 
 
 
 
 
 

 
Στο πάνω µέρος βλέπετε τη γραµµή µενού της εφαρµογής που αποτελείτε από τις 
εξής επιλογές:  
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

FILE : 
 
File->New : ∆ηµιουργεί µια 
καινούρια εργασία κατασκευής 
µενού, δίνοντας σας τη 
δυνατότητα να επιλέξετε θέµα 
από τη συλλογή θεµάτων. 
 
File->Open : Ανοίγει µια 
εργασία ενός έτοιµου µενού 
που έχει την κατάληξη .awm. 
 
File>Save : Αποθηκεύει την 
εργασία σας σε ένα αρχείο 
*.awm. 
 
File->Save As : Αποθηκεύει την εργασία σας µε ένα διαφορετικό όνοµα. 
 
File->Open Example : Ανοίγει ένα παράδειγµα από µια λίστα έτοιµων 
παραδειγµάτων που σας  προσφέρει η εφαρµογή. 
 
File->Export Project : Εξάγει την εργασία που πραγµατοποιήσατε έτσι ώστε να 
µπορείτε να την χρησιµοποιήστε και σε άλλους υπολογιστές χωρίς να έχετε 
προβλήµατα µε τις διαδροµές των αρχείων και των εικόνων. 
  
File->Import Project : Εισάγει µια έτοιµη εργασία στη εργασία που ήδη 
επεξεργάζεστε.  
 
File->Exit : Κλείνει την εφαρµογή. 
 
 
 
EDIT : 
  
Edit->Undo : Αναιρεί την τελευταία σας πράξη. 
  
Edit->Redo : Ακυρώνει την αναίρεση που κάνατε. 
 
Edit->Cut Item : Αποκόπτει το επιλεγµένο στοιχείο 
(οµάδα ή αντικείµενο). 
  
Edit->Copy Item : Αντιγράφει το επιλεγµένο 
στοιχείο (οµάδα ή αντικείµενο) 
 
Edit->Paste Item : Εισάγει το στοιχείο που είχε αποκοπεί ή αντιγραφεί 
προηγουµένως. 
 
Edit->Paste Values to Item : Εισάγει µόνο τις τιµές, ενός στοιχείου που είχε 
αντιγραφεί προηγουµένως. 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

VIEW :  
 
View->Help Tips : Εµφανίζει ή 
αποκρύπτει ένα πλαίσιο µε χρήσιµες 
πληροφορίες σχετικά µε το στοιχείο που 
έχετε επιλεγµένο. 
 
 
 
 
 
 
View->Menu Editor 
Preview : Εµφανίζει ή 
αποκρύπτει ένα πλαίσιο µε 
την προεπισκόπηση του 
µενού από όπου µπορείτε 
κάνοντας δεξί κλικ σε ένα 
αντικείµενο να επιλέξετε τι 
ενέργεια να εκτελέσει. 
 
 
 
 
 
 
 
View->Style Editor 
Preview: Εµφανίζει ή 
αποκρύπτει ένα πλαίσιο µε 
την προεπισκόπηση του 
µενού, καθώς επεξεργάζεστε 
το στυλ που θα έχει. 
 
 
 
 
 
 
 
STRUCTURE : 
 
Structure->Add Item :  
Προσθέτει ένα καινούριο  
αντικείµενο στο µενού. 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
Structure->Add Submenu 
Group to Item : Προσθέτει 
ένα υποµενού (submenu) στο 
επιλεγµένο αντικείµενο. 
 
 
 
 
 
Structure->Add Separator : Εισάγει ένα  
διαχωριστή (separator) κάτω από το επιλεγµένο 
 αντικείµενο. 
 
 
 
 
 
 
 
Structure->Move Item Up : 
Μετακινεί το επιλεγµένο Item 
µια θέση πάνω. 
 
 
 
 
 
 
 
Structure->Move Item D
Μετακινεί το επιλεγµένο
αντικείµενο µια θέση κάτω. 
 

own: 
 

tructure->Delete Item : 

 
 
 
 
 
 
S
∆ιαγράφει το επιλεγµένο 
αντικείµενο από το µενού. 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

THEME : 

heme->Apply Theme to Menu : Ανοίγει τη συλλογή των έτοιµων θεµάτων από 

heme->Export New Theme : 

ινούργιο 

ι 

ε µε το 

OOLS :

 
T
όπου µπορείτε να επιλέξετε ένα θέµα το οποίο θα πάρει τη θέση αυτού που 
επεξεργάζεστε.  Το καινούριο θέµα φέρει όλες τις δικές του ιδιότητες όσον αφορά την 
εµφάνιση, αλλά θα προσαρµοστεί στις πληροφορίες που έχετε εσείς ήδη δώσει. 
  
 
 
 
 
T
Εξάγει την εργασία που 
επεξεργάζεστε ως ένα κα
θέµα στη συλλογή θεµάτων της 
εφαρµογής. Το θέµα αυτό θα είνα
βασισµένο στις ρυθµίσεις που 
κάνατε στην εµφάνιση του. 
Μπορείτε να το αποθηκεύστ
όνοµα που επιθυµείτε και τελικά να 
το χρησιµοποιείτε µε την εντολή 
Apply Theme to Menu. 
 
 
 
 
 
 
 
T  

ools->Refresh Menu Preview : 
 

ools->Compile Menu : Συντάσσει 

 

ools->Project Properties : Ανοίγει 
 

 σας.  

ools->Link Copmiled Menu to Web Page(s) : Συνδέει το µενού που κάνατε 

 
T
Ανανεώνει την προεπισκόπηση του
µενού στο πλαίσιο Menu Editor 
Preview, κάθε φορά που γίνεται 
κάποια αλλαγή σε αυτό.  
 
T
το αρχείο .awm σε ένα αρχείο .js το 
οποίο θα συνδεθεί µε την ιστοσελίδα
σας.  
 
T
ένα πλαίσιο όπου µπορείτε να
ρυθµίσετε τις ιδιότητες της εργασίας
 
T
compile, µε την ιστοσελίδα σας.  
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

Tools->Import Frontpage Navigation Structure : Εισάγει µια δοµή πλοήγησης της 

ools->Create Sitemaps->Create 

 

ες κτλ) 

ools->Create Sitemaps->Create Google Sitemap : ∆ηµιουργεί ένα αρχείο 

ools->Create Sitemaps->Create ROR Sitemap : ∆ηµιουργεί ένα αρχείο ror.xml 

ools->Check For Updates : Ελέγχει αν υπάρχουν καινούριες εκδόσεις της 

ools->Customize AllWebMenus : Σας επιτρέπει να ρυθµίσετε κάποιες γενικές 

ELP :

εφαρµογής Frontpage. Έτσι µπορείτε να επεξεργαστείτε τη δοµή αυτή µε το 
AllWebMenus και να δηµιουργήσετε µια καινούρια δοµή (Menu Structure). 
 
 
 
T
Generic Sitemap : ∆ηµιουργεί ένα 
“χάρτη” της δοµής του µενού σας. Ο
“χάρτης” αυτός περιέχει όλες τις 
πληροφορίες του µενού που 
δηµιουργήσατε (Links, Εικόν
και εξάγεται σε ένα απλό αρχείο 
.html. 
 
 
T
sitemap.xml βασισµένο στις ιστοσελίδες που είναι συνδεδεµένες στα αντικείµενα του 
µενού σας, το οποίο σας επιτρέπει να γνωστοποιήσετε στις µηχανές αναζήτησης τις 
ιστοσελίδες σας αλλά και πληροφορίες σχετικά µε τις τελευταίες αλλαγές που κάνατε, 
τη συχνότητα που τις τροποποιείτε κα.  
 
T
βασισµένο στις ιστοσελίδες που είναι συνδεδεµένες στα αντικείµενα του µενού σας. 
Το ROR είναι ένα συνεχώς αναπτυσσόµενο εργαλείο, XML µορφής, που περιγράφει 
την ιστοσελίδα σας µε τέτοιο τρόπο ώστε να εντοπίζετε πιο εύκολα από τις µηχανές 
αναζήτησης. 
 
T
εφαρµογής στον δικτυακό της τόπο. 
 
T
ιδιότητες της εφαρµογής.  
 
 
H  

elp->Contents : Ανοίγει το αρχείο της Βοήθειας. 

elp->Search For Help On : Ανοίγει την 

elp->How do I : ∆ίνει συµβουλές για την επίτευξη 

 

elp->Optimization Techniques : ∆ίνει συµβουλές 
πως θα αυξήσετε την ταχύτητα ανάπτυξης του µενού.  

 
H
 
H
αναζήτηση στο αρχείο της βοήθειας. 
  
H
κάποιων εργασιών. 
 
Help->Tip of the Day : ∆είχνει µια συµβουλή κάθε 
φορά που ανοίγετε την εφαρµογή. 
 
H
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
Help->How to Register : Εµφανίζει πληροφορίες σχετικά µε τη διαδικασία 
νεργοποίησης της εφαρµογής. 

s : Ξεκινάει τη διαδικασία ενεργοποίησης του 
ρογράµµατος πληκτρολογώντας τον κωδικό ενεργοποίησης. 

µε  τη ιστοσελίδα της 
φαρµογής. 

ne Support Center : Σας συνδέει µε το κέντρο υποστήριξης πελατών, 
ου βρίσκεται στο δικτυακό τόπο του προγράµµατος. 

ς σχετικά µε την εφαρµογή(πχ 
κδοση, κωδικό εγκατάστασης, κωδικό ενεργοποίησης ) 

άτω από τη γραµµή µενού εµφανίζεται η παρακάτω γραµµή εργαλείων µε κάποιες 
πό τις βασικές και πιο χρήσιµες εντολές. 

ε
 
Help->Register AllWebMenu
π
 
Help->Visit Likno on the Web : Σας συνδέει αυτόµατα 
ε
 
Help->On-li
π
 
Help->About : Εµφανίζει ένα πλαίσιο µε πληροφορίε
έ
 
 
Κ
α
 

 
 

Η εφαρµογή έχει καθορίσει αρκετές συντο  για γρήγορη πρόσβαση σε βασικές
λειτουργίες:  

ι τη βοήθεια για τη κάθε ιδιότητα. 

του µενού. 

e. 

 της σύνδεσης του 
ενού(link). 

ηµιουργεί µια καινούργια εργασία.  

. 

 αντιγράφηκε προηγουµένως. 

κε. 
 

µεύσεις  

 
F1-> Προβάλε
 
F12-> Ανοίγει το παράθυρο της προεπισκόπησης 
 
Ctrl + F12-> Ανοίγει το παράθυρο µε τις επιλογές του compil
 
Shift + Ctrl F12-> Ανοίγει το παράθυρο µε τις επιλογές
µ
 
Ctrl + N-> ∆
 
Ctrl + O-> Ανοίγει ένα έτοιµο µενού .awm. 
 
Ctrl + S-> Αποθηκεύει την τρέχουσα εργασία
 
Ctrl + X-> Αποκόπτει το επιλεγµένο στοιχείο. 
 
Ctrl + C-> Αντιγράφει το επιλεγµένο στοιχείο. 
 
Ctrl + V-> Εισάγει το στοιχείο που αποκόπηκε ή
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Ctrl + A-> Εισάγει µόνο τις τιµές του αρχείου που που αποκόπηκε ή αντιγράφη



Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

∆ΗΜΙΟΥΡΓΙΑ ΜΕΝΟΥ ΣΕ 5 ΑΠΛΑ 
ΒΗΜΑΤΑ 

τασκευάστε τ
 

ΒΗΜΑ 1: Κα ο Μενού σας  
 

 κατασκε ίο µενού 
tem) µπορεί να προστεθεί σε ένα σηµείο που θέλουµε µέσα στο µενού, κάνοντας 

το καινούριο αντικεί χρησιµοποιώντας 
τις επιλογές 

 

Η υή ενός µενού είναι µια πολύ απλή διαδικασία. Ένα νέο στοιχε
(i
δεξί κλικ και επιλέγοντας Add Item.  

 
 
 
 
 
 
 
 

µενο µπορείτε να το τοποθετήσετε οπουδήποτε 
Move Item Up/Down είτε τις λειτουργίες Cut/Paste. 

Μια νέα οµάδα υποµενού  (Submenu Group) προστίθεται κάνοντας δεξί κλικ στο 
“item” που επιθυµείτε να έχει το  υποµενού (submenu) και επιλέγοντας Add 
Submenu Group to Item. 
 

 
 
όπου επίσης µπορείτε να χρησιµοποιήσετε τις λειτουργίες  Cut/Paste. 

ς ένα Item,  µπορείτε να δείτε στο δεξιό πλαίσιο το πλήρες σύνολο των 
al, on Mouse 

 

 Επιλέγοντα
ιδιοτήτων του σε  κάθε µιας από τις 3 καταστάσεις  των επιλογών Norm
Over και On Mouse Click. 
 
 

        
                  Normal                      On Mouse Over             On Mouse Click  

τας και 
οποθετώντας την τιµή που επιθυµείτε έτσι ώστε να προσαρµόστε πλήρως το µενού 

σ

 
 
Μπορείτε να τροποποιήσετε κάθε µια από τις ιδιότητες επιλέγον 
τ
στις απαιτήσεις ας.  
Οι ιδιότητες (Properties) χωρίζονται σε 2 κατηγορίες: σε Group Properties και σε 
Item Properties.  
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
Group Properties 

Οι Group Properties έχουν ρά και την εµφάνιση της 
περιοχής που περιέχει µια οµάδα από αντικείµενα, όπως είναι τα Main Menus και τα 

Group Content Properties

 
 να κάνουν µε τη συµπεριφο

Submenus. Έτσι λοιπόν έχουµε τις Group Content Properties, που είναι οι ιδιότητες 
που περιγράφουν το πραγµατικό περιεχόµενο του κάθε Group και  τις Group Style 
Properties, ιδιότητες που περιγράφουν την εµφάνιση και τη συµπεριφορά της 
οµάδας, παρά το πραγµατικό της περιεχόµενο.  
 
 

 

 
 

 
 
 

eader Text :

 
 
 
H  Καθορίζει το κείµενο που θα εµφανίζεται στην επιγραφή 

eader) του µενού. Το κείµενο αυτό προσδιορίζει  το group που 

eader Image :

(h
εµφανίζεται στη δοµή του µενού (menu stracture) που βρίσκεται στην 
αριστερή πλευρά.  
 
 
 
 
 
 
H  Τοποθετεί µια εικόνα στο header ενός group. 
πό την επιλογή Image Placement µπορείτε να καθορίσετε αν η 

ιο 
Α
εικόνα θα είναι µόνη της, αν θα είναι µαζί µε κείµενο και σε πο
σηµείο θα τοποθετηθεί.  
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
 
Positioning : Με την ιδιότητα αυτή, όπως θα δείτε και παρακάτω, καθορίζετε ο 
ρόπος και το µέρος που θα τοποθετηθεί το µενού µέσα στην ιστοσελίδα. 

ovable :

τ
 
 
 
 
 
M  Επιτρέπει στον επισκέπτη να τοποθετήσει το 
ενού σε διαφορετική θέση µέσα στην ιστοσελίδα, 

er, 

enu Drifts on Scroll :

µ
χρησιµοποιώντας την τεχνική “drag and drop”. Κάτι 
τέτοιο όµως είναι εφικτό εφόσον το µενού έχει head
από όπου και θα γίνει η κίνηση.  
 
 
 
 
 
 
 
M  Ελέγχει τη 
υµπεριφορά του µενού καθώς ο επισκέπτης 

 το µενού 
 

ως.   

ticky Submenus :

σ
κάνει “scroll” στην ιστοσελίδα. Έτσι
µπορεί είτε να παραµείνει στατικό ανεξάρτητα
από την κίνηση της σελίδας είτε να την 
ακολουθεί , απότοµα ή σταδιακά, µέχρι να 
φτάσει στο σηµείο που ήταν προηγουµέν
 
 
 
 
 
 
S  Καθορίζει αν το 
ubmenu κλείσει όταν ο δείκτης του 

υ  
γίνει  

 

eader Tooltip :

s
ποντικιού αποµακρυνθεί από πάνω το
ή αν θα παραµείνει ανοικτό µέχρι να 
ένα “κλικ” κάπου αλλού.  
 
 
 
 
 
H  Καθορίζει το κείµενο  που θα 
µφανιστεί όταν ο κέρσορας µείνει για λίγο πάνω από το ε

header. 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
 
Footer Text : Καθορίζει το κείµενο που θα εµφανίζεται ως 
ποσηµείωση (footer) του µενού. 

ooter Image :

υ
 
 
 
 
 
 
F  Τοποθετεί µια εικόνα στο footer ενός group. Από 
ην επιλογή Image Placement µπορείτε να καθορίσετε αν η εικόνα 

ooter Tooltip :

τ
θα είναι µόνη της, αν θα είναι µαζί µε κείµενο και σε ποιο σηµείο 
θα τοποθετηθεί.  
 
 
 
 
 
 
 
 
F  Καθορίζει το κείµενο  που θα 
µφανιστεί όταν ο κέρσορας µείνει για λίγο πάνω από 

-Index :

ε
το footer. 
 
 
 
 
 
 
 
Z  Αναθέτει µια τιµή η οποία καθορίζει πόσο ορατό θα είναι ένα αντικείµενο 
ο οποίο τοποθετείται πάνω από κάποιο άλλο. Η µέγιστη τιµή, όπου το µενού πχ είναι 

 
  

τ
πλήρως ορατό, είναι 1000(που είναι και η προεπιλογή του προγράµµατος).     
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

PopUp : Αποτελεί µια ειδική ιδιότητα η οποία χρησιµεύει, θέτοντας την τιµή “Yes”, 
ν θέλετε να εµφανιστεί το µενού σας ΜΟΝΟα  αφού χρησιµοποιήσετε κάποια 

avascript Command on Appear :

λειτουργία Javascript. Όπως πχ να  αναδυθεί το µενού στο σηµείο που κάνετε δεξί 
κλικ. 
 
 
J  Εκτελεί έναν κώδικα javascript κατά την 
µφάνιση του µενού σε µια ιστοσελίδα. Όπως πχ ένα µήνυµα σε ένα µικρό παράθυρο. ε

 

 
 
Javascript Command on Disappear : Εκτελεί έναν κώδικα javascript κατά την 
ξαφάνιση του µενού από µια ιστοσελίδα. Όπως πχ ένα µήνυµα σε ένα µικρό 

Group Style Properties

ε
παράθυρο. 
 
 
 

 

 
 

 
 
 

ssigned Style:

 
 
A  Η ιδιότητα αυτή 
ληροφορεί ποιο group ,το “main 

 

λο.     

π
menu” ή το “sub group”, 
επεξεργαζόµαστε και δίνει τη
δυνατότητα µετάβασης από το 
ένα στο άλλο καθώς και τη 
επιλογή αντιγραφής όλων των 
τιµών ενός “style” σε ένα άλ
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
Type : Καθορίζει αν το Group θα  

ain 

 να 

λύτερο

as Header :

εµφανίζετε κάθετα ή οριζόντια 
ή ακόµα και µε τη µορφή 
“menubar” (µόνο για τα m
menu group). Επίσης µε την 
επιλογή “Uniform Items” 
µπορείτε να ορίσετε τα item
έχουν το ίδιο µέγεθος 
προσαρµοσµένα στο µεγα
είτε όχι.    

  

 
 
 
 
 
H  Καθορίσει  

τε την 
 απ

”.  

as Footer :

αν ένα µενού θα έχει 
header ή όχι. Αν έχει 
µπορείτε να 
µορφοποιήσε
εµφάνιση του header
 την επιλογή “Header Style

ό 

 
 
 
 
 
H  Καθορίσει  

τε την 
από

 

ppears – When :

αν ένα µενού θα έχει 
footer ή όχι. Αν έχει 
µπορείτε να 
µορφοποιήσε
εµφάνιση του footer 
 την επιλογή “Footer Style”. 

 

 
 
 
 
A   

ίζεται 

ά

 

Καθορίζει πότε θα  
εµφανίζεται ένα 
subgroup. Εµφαν
είτε κάνοντας κλικ στο 
γονικό του item είτε απλ
τοποθετώντας τον κέρσορα 

  

 πάνω από αυτό. 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

Appears – Where : 

έση µε 

ί 

. 

 

ppears – How :

Καθορίζει πού θα 
εµφανίζεται το 
υποµενού σε σχ
το γονικό του µενού. 
Μπορείτε έτσι να 
επιλέξετε σε ποια 
πλευρά θα αναδυθε
αλλά και σε πόση 
απόσταση από αυτό
 
 
 
 
 
 
 
 
A  Καθορίζει 

ν τρόπο 

ση 
 και 

ς.   

ppears – Aligned with :

πώς θα εµφανίζεται το 
υποµενού. Ρυθµίζετε το
εµφάνισης, πχ αν αναδύεται 
στιγµιαία, σταδιακά ή µε χρή
κάποιου ειδικού εφέ, αλλά
την κατεύθυνση της ανάδυση
 
  
 
 
 
 
 
 
A   
αθορίζει πως το 

 σχέση 
 item. 

 

η, 
 

  
 

Κ
υποµενού θα 
ευθυγραµµιστεί σε
µε το γονικό του
Έτσι µπορείτε να 
ευθυγραµµίσετε το 
υποµενού σε όποιο
σηµείο θέλετε να 
εµφανίζεται σε σχέσ
είτε µε το γονικό του
item, είτε µε το γονικό 
του group, αλλά και να
καθορίσετε ακριβώς την
 

απόσταση από αυτό.     
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

Opacity : Ρυθµίζει την εµφάνιση του group 

η 
νές.  

 

ώστε να εµφανίζεται ηµιδιαφανές. Θέτοντας 
λοιπόν την µέγιστη τιµή 100, το group 
εµφανίζεται πλήρως αδιαφανές και µε τ
ελάχιστη τιµή 0, εµφανίζεται πλήρως διφα
 
 
 
 
 
 
Background Color : Χρωµατίζει το 
background ενός group. Μπορείτε να 
επιλέξετε το χρώµα που επιθυµείτε να 
εµφανίζεται στο background του group
από µια  πλούσια συλλογή χρωµάτων, ή 
να επιλέξτε “none” και το background να
εµφανίζεται διαφανές.  
 

, 

 

ackground Tile Image :

 
 
 
 
B  Εµφανίζει 

ρη 

α γεµίσει ο 

 

roup Border :

µια εικόνα στο background ενός 
group. Εάν η εικόνα είναι µικρότε
από το background τότε 
επαναλαµβάνεται µέχρι ν
χώρος και εάν δεν επιλέξτε καµία 
εικόνα τότε εµφανίζεται το χρώµα 
που ορίσατε ως background.  
 
 
 
 
 
G  Καθορίζει το στυλ του περιγράµµατος κάθε group. Έτσι µπορείτε να 
ρυθµίσετε τον τύπο, το χρώµα και το πάχος του κάθε περιγράµµατος.  
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
Distance Between Items : Καθορίζει την 

oup. 
 

 

απόσταση µεταξύ των item µέσα σε ένα gr
Η προκαθορισµένη τιµή είναι το 0, που είναι και
η ελάχιστη. 

 

 
 
 

Item Properties 
 

Οι Item Properties αντίστοιχα, έχουν να κάνουν µε τη συµπεριφορά και την εµφάνιση 

Item Content Properties

του κάθε αντικειµένου (Item) ξεχωριστά. Έτσι λοιπόν έχουµε τις Item Content 
Properties, που είναι οι ιδιότητες που περιγράφουν το πραγµατικό περιεχόµενο του 
κάθε Item και  τις Item Style Properties, ιδιότητες που περιγράφουν την εµφάνιση 
και τη συµπεριφορά της οµάδας, παρά το πραγµατικό της περιεχόµενο.  
 
 

 
 
 

 
 

ext :

 
 
T  Καθορίζει το κείµενο που θα εµφανιστεί στη θέση του επιλεγµένου item. Το 
κείµενο αυτό µπορεί να διαφοροποιηθεί και για τις 3 καταστάσεις (Normal, Mouse 
Over, Mouse Click).   
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
Image : Απεικονίζει µια εικόνα στο item. Από την επιλογή Image Placement 

               

καθορίζετε αν η εικόνα θα είναι µόνη της, αν θα είναι µαζί µε κείµενο και σε ποιο 
σηµείο θα τοποθετηθεί.   
 
 

                
 

 
 

Link :
 

 Καθορίζει την ιστοσελίδα ή το αρχείο που θα ανοίξει κάνοντας κλικ σε ένα 

ttp://www.likno.com  
q.html  

AllWebMenus.exe  

tml   ( κάνοντας link σε ένα server)  

item. Αν θέλετε να το πετύχετε αυτό, θα πρέπει να ορίζετε ως link ολόκληρη τη 
διαδροµή του αρχείου (path). Μερικά σωστά παραδείγµατα είναι τα εξής:  
 
h
http://www.likno.com/fa
ftp://www.likno.com/downloads/
mailto:support@likno.com  
file:////server1/testarea/test.h
file:///C:/testarea/test.html      (κάνοντας link στον σκληρό δίσκο) 
file:///C:/fotos/image1.jpg   (κάνοντας link σε εικόνα) 
 
 

 
 

Ο καλύτερος πάντως τρόπος, και πιο απλός, όταν θέλετε να επιλέξετε ένα αρχείο 

 

 

µέσα από τον τοπικό σας δίσκο είναι να χρησιµοποιήσετε το button που φαίνεται 
παρακάτω: 

 

 
 

πορείτε επίσης να κάνετε   link και σε κάποιο σηµείο µέσα στην ίδια τη σελίδα που 

ς

ttp://www.mysite.com/info.html#anchor 

 
Μ
βρίσκεται το µενού χρησιµοποιώντας το εργαλείο Anchor (Άγκυρα) των 
προγραµµάτων σχεδίασης ιστοσελίδας, όπω  παρακάτω:  
 
h
 
 

ΤΕΙ Σερρών – Τµήµα Πληροφορικής & Επικοινωνιών 
 

37



Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
 
Link Target : Καθορίζει το παράθυρο ή το πλαίσιο στο οποίο θα ανοίξει το αρχείο 
στο έγινε link. Έτσι µπορείτε να επιλέξετε να ανοίξει το link στο ίδιο πλαίσιο ή 
παράθυρο που βρίσκεται το µενού, σε ένα νέο παράθυρο ανεξάρτητα από αυτό που 
βρίσκεστε, στο ίδιο παράθυρο αντικαθιστώντας το ήδη υπάρχον και τέλος σε ένα 
συγκεκριµένο πλαίσιο δηλώνοντας το όνοµα του.    
 

 
 

 

Status Bar Text :
 

 Καθορίζει το κείµενο που θα εµφανιστεί στη γραµµή κατάστασης 

ooltip :

ενός browser, όταν ο κέρσορας περάσει πάνω από ένα item.  Η ιδιότητα αυτή είναι 
ενεργή µόνο για την κατάσταση “on mouse over”. 
 
 
 
 
 
 
T  Καθορίζει το κείµενο που εµφανίζεται πάνω από 

as Separator :

ένα item, όταν ο επισκέπτης αφήσει για λίγο τον κέρσορα 
πάνω του.   
 
 
 
 
 
 
 
H  Τοποθετεί µια διαχωριστική 

 

 

µπάρα (separator bar) κάτω από το επιλεγµένο 
item. Μπορείτε επίσης να ρυθµίσετε το πλάτος, 
το χρώµα, τη σκιά και τέλος την απόσταση που 
θα έχει ο separator από τα γειτονικά του items. 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
Javascript Command : Καθορίζει µια εντολή Javascript που θα εκτελεστεί όταν το 
item βρεθεί σε µια από τις 3 καταστάσεις “Normal, On Mouse Over, On Mouse 
Click”. Στην κατάσταση “Normal” η εντολή θα εκτελεστεί µόλις ο κέρσορας 
αποµακρυνθεί από την περιοχή του item, στην κατάσταση “On Mouse Over” θα 
εκτελεστεί όταν ο κέρσορας περάσει πάνω από το item και στην κατάσταση “On 
Mouse Click” θα εκτελεστεί αφού γίνει κλικ στο item. Μπορείτε να χρησιµοποιήσετε 
πάνω από µια εντολές javascript διαχωριζόµενες από ένα ερωτηµατικό (;).  
 
 

 
 

Item Style Properties

 
 
 
 

 
 
 

 
 

ssigned Style :

 
 
A   Η ιδιότητα αυτή 

em” ή 
 

. 

πληροφορεί ποιο item ,ένα “main it
ένα “sub item”, επεξεργάζεστε και δίνει τη
δυνατότητα µετάβασης από το ένα στο 
άλλο καθώς και τη επιλογή αντιγραφής 
όλων των τιµών ενός “style” σε ένα άλλο
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
 
Content Alignment : Καθορίζει την στοίχιση 

ext Fond :

του επιλεγµένου item στην περιοχή του µέσα 
στο µενού. Μπορείτε να κάνετε στοίχιση 
δεξιά, αριστερά και στο κέντρο.   
 
 
 
 
 
 
 
 
T  Καθορίζει τη γραµµατοσειρά 

ext Size :

µε την οποία θα εµφανίζεται το κείµενο 
του επιλεγµένου αντικειµένου. 
 
 
 
 
 
 
 
 
 
T  Καθορίζει το µέγεθος που θα 

τε 

ext Decoration :

έχει το κείµενο του επιλεγµένου item. Έχε
τη δυνατότητα να αυξοµειώστε το µέγεθος 
µε βάση τα pixels, η ακόµα και µε 
ποσοστιαία αναλογία. 
 
 
 
 
 
 
 
 
T  Καθορίζει 

άγια 

derlined

αν το κείµενο του item θα 
εµφανίζεται µε έντονα 
γράµµατα (bold), µε πλ
γράµµατα (italic) ή 
υπογραµµισµένο (un ). 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
Text Color : Καθορίζει το χρώµα του 

. 
τε 

 

ontent Padding :

κειµένου του επιλεγµένου αντικειµένου
Μπορείτε να επιλέξτε το χρώµα που θέλε
είτε από µια πλούσια παλέτα χρωµάτων που 
σας δίνει το πρόγραµµα είτε θέτοντας 
αυτόµατα τον δεκαεξαδικό αριθµό που
αντιστοιχεί σε κάθε χρώµα.  
 
 
 
 
 
 
 
 
C  Καθορίζει την ακριβή 

µενο 
 

ext Margin :

απόσταση σε pixels, που θα έχει το περιεχό
(κείµενο ή εικόνα) του item, από όλα τα άκρα της
περιοχής του. 
 
 
 
 
 
 
 
 
T  Καθορίζει την 

ι το 
 

order :

απόσταση σε κενά , που θα έχε
κείµενο του item, από το δεξί και το
αριστερό άκρο της περιοχής του. 
   
 
 
 
 
 
 
 
 
B  Καθορίζει το στυλ του περιγράµµατος που θα 

 
έχει το επιλεγµένο item. Μπορείτε να τοποθετήσετε 
περίγραµµα στο item, ανεξάρτητα από το περίγραµµα
του group στο οποίο ανήκει. 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
Background Color : Χρωµατίζει το 

ετικό 

ackground Tile Image :

background ενός item. Μπορείτε να 
χρωµατίσετε το κάθε item µε διαφορ
χρώµα επιλέγοντας το από την παλέτα 
χρωµάτων του προγράµµατος.  
   
 
 
 
 
 
 
B  Τοποθετεί µια εικόνα στο 

ackground Image 1 :

background του επιλεγµένου item. Εάν η εικόνα είναι 
µικρότερη επαναλαµβάνεται µέχρι να γεµίσει όλη η 
περιοχή του item. Σε περίπτωση που υπάρχουν και 
άλλες εικόνες (background image 1, background 
image 2), τότε µπορείτε να επιλέξετε η εικόνα 
τοποθετηθεί ανάµεσα από τις 2.    
 
 
 
 
 
 
 
 
B  Τοποθετεί µια εικόνα στο 

 

ackground Image 2 :

background ενός item στοιχισµένη µε το αριστερό 
του άκρο. Η εικόνα αυτή δεν επαναλαµβάνεται εάν
είναι µικρότερη και καταλαµβάνει το χώρο που της 
ορίζετε εσείς.  
  
 
 
 
 
 
 
 
 
B  Τοποθετεί µια εικόνα στο 

κρο. background ενός item στοιχισµένη µε το δεξί του ά
Η εικόνα αυτή δεν επαναλαµβάνεται και καταλαµβάνει 
το χώρο που της ορίζετε εσείς. 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
 
 
Background Area Size : Θέτει το 

m. 

oreground Image :

ελάχιστο πλάτος και ύψος του 
background του επιλεγµένου ite
Μπορείτε επίσης να  επιλέξτε να 
προσαρµόζεται αυτόµατα µε το 
περιεχόµενο του. 
  
 
 
 
 
 
 
F  Τοποθετεί µια εικόνα στο item 

Has Submenu” Image :

προϋποθέτοντας ότι η ιδιότητα <Item Image> είναι 
κενή. Μπορείτε να επιλέξετε σε ποιο σηµείο θα 
τοποθετήσετε την εικόνα σε σχέση µε το item. 
  
 
 
 
 
 
 
 
“  Τοποθετεί µια εικόνα στο 

οµένου 

 έχει 

ursor :

επιλεγµένο item έτσι ώστε να δώσει έµφαση στην 
ύπαρξη ενός νέου submenu. Η εικόνα αυτή 
εµφανίζεται µόνο στο δεξιό άκρο του περιεχ
του. Μπορείτε επίσης να επιλέξετε αν θέλετε να 
εµφανίζεται η εικόνα πάντα ή µόνο όταν ένα item
υποµενού.  
 
 
 
 
 
 
 
C  Σας επιτρέπει να αλλάξετε το σχήµα του κέρσορα 

ν 

 

καθώς περνάει πάνω από το επιλεγµένο αντικείµενο. Την 
ιδιότητα αυτή µπορείτε να τη χρησιµοποιήσετε µόνο για τη
κατάσταση “On Moue Over” . 
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Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

ΒΗΜΑ 2 : Συνδέστε (Link) το µενού στην Ιστοσελίδα  
 
Η διαδικασία της σύνδεσης του µενού που κατασκευάσατε µε την ιστοσελίδα σας 
είναι πολύ απλή: 
 Το πρώτο πράγµα που πρέπει να κάνετε είναι να συντάξετε (Compile) το µενού που 
δηµιουργήσατε. Αυτό το επιτυγχάνετε επιλέγοντας  από τη γραµµή εργαλείων Tools-
>Compile Menu. Αν δεν έχετε ορίσει το φάκελο που έχετε αποθηκεύσει, τοπικά, την 
ιστοσελίδα σας(“Site Root Folder”), θα εµφανιστεί το παράθυρο “Compile 
Properties->Folders” που θα σας ζητήσει να τον ορίσετε. Αυτό είναι και το σηµείο 
όπου θα συνταχθεί το µενού σας. Η σύνταξη(compilation) αυτή δηµιουργεί το αρχείο 
και µια οµάδα από βιβλιοθήκες αποτελούµενες από όλες τις απαραίτητες εντολές  
javascript που χρειάζονται για να λειτουργήσει σωστά το µενού. 
 
Πιο αναλυτικά, αρχικά γίνεται compile ενός αρχείου .awm σε ένα αρχείο .js το οποίο 
θα συνδεθεί µε την ιστοσελίδα σας. Όταν κάνετε compile ένα µενού πχ το menu.js, 
δηµιουργούνται τα ακόλουθα στοιχεία µέσα στην ίδια διαδροµή:  
 

1. Το αρχείο εικόνας awmmenupath.gif. Αυτή είναι πολύ µικρή εικόνα (όσο 
ένα εικονοστοιχείο) που χρησιµοποιείτε από το πρόγραµµα για επιλύσει 
ανεπάρκειες παλαιοτέρων browsers. 

 
2. Το φάκελο awmdata (προεπιλογή ή κάποιο άλλο όνοµα για το συγκεκριµένο 

φάκελο για την ίδια πάντα διαδροµή). Ο φάκελος αυτός περιέχει τις 
απαραίτητες javascript βιβλιοθήκες(awmlibX.js) της κατασκευής του µενού 
µαζί µε τις εικόνες που χρησιµοποιούνται από το συγκεκριµένο µενού.  

 
Το αρχείο awmmenupath.gif και ο φάκελος awmdata είναι απαραίτητα στοιχεία για 
τη σωστή λειτουργία του µενού και πρέπει πάντα να βρίσκονται στην ίδια διαδροµή 
µε αρχείο menu.js.    
Μπορείτε να ρυθµίσετε τις ιδιότητες του compile επιλέγοντας από τη γραµµή 
εργαλείων   Tools->Project Properties->Compile Properties. 
 
 
 
 
Folders : Καθορίζει τους 
φακέλους και τα αρχεία που θα 
δηµιουργηθούν όταν κάνετε 
compile το µενού σας. Μπορείτε 
να ορίσετε πού έχετε αποθηκεύσει 
την ιστοσελίδα σας(Site_Root 
folder), το όνοµα του αρχείου 
javascript που δηµιουργείται 
(Compile menu name) και τα 
ονόµατα των υποφακέλων όπου θα 
αποθηκευτούν τα αρχεία του 
µενού, οι javascript βιβλιοθήκες 
και οι εικόνες.            
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Cross-Frame Support :  
Σε κάποιους browsers  δεν 
επιτρέπεται ένα αντικείµενο να 
εµφανίζεται έξω από το  
προκαθορισµένο του πλαίσιο. 
Εποµένως και ένα µενού δεν 
µπορεί να ξεδιπλώσει τα 
υποµενού του έξω από το 
πλαίσιο στο οποίο βρίσκεται. 
Με αυτήν την επιλογή 
µπορείτε να ορίσετε το µενού 
να εµφανίζεται σε ένα πλαίσιο 
και το υποµενού να 
εµφανίζεται σε ένα 
διαφορετικό πλαίσιο, του 
οποίου το όνοµα και δηλώνετε. 
Μπορείτε επίσης να ρυθµίσετε  
που ακριβώς θα αναδυθεί.   
 
 
 
 
 
Optimization : Με αυτήν την 
επιλογή σας δίνετε η δυνατότητα 
να αυξήσετε την ταχύτητα της 
αναδίπλωσης του µενού σας. 
Αυτό το επιτυγχάνετε αγνοώντας 
την κατάσταση OnMouseClick.  
 
 
 
 
 
 
 
 
 
FrontPage Support : Αν είστε 
χρήστης του FrontPage µπορείτε 
να κάνετε Link το µενού σας σε 
ένα συγκεκριµένο πλαίσιο ώστε 
να παραµένει σταθερό και να 
µην χρειάζεται να το συνδέσετε 
µε κάθε µια σελίδα ξεχωριστά.   
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Advanced Scripting : Η ιδιότητα 
αυτή σας επιτρέπει να εισάγετε 
στο αρχείο menu.js επιπλέον 
κώδικα javascript. Τον κώδικα 
τον εισάγεται άµεσα χωρίς τα 
εισαγωγικά του στοιχεία και θα 
εκτελείτε αυτόµατα κάθε φορά 
που θα εµφανίζεται το µενού στην
ιστοσελίδα σας.    

 

 
 
 
 
 
 
RTL Languages Support :  
Ρυθµίζετε το µενού σας να κάνει 
compile από τα δεξιά προς τα 
αριστερά, έτσι ώστε να 
υποστηρίζονται και οι ιστοσελίδες 
που χρησιµοποιούν γλώσσες µε 
την ιδιαιτερότητα αυτή.      
 
 
 
Αφού κάνετε compile το µενού, θα πρέπει να το συνδέσετε(link) µε την ιστοσελίδα 
σας. Μπορείτε να το κάνετε αυτό επιλέγοντας Tools->Link Menu. Η διαδικασία της 
σύνδεσης ουσιαστικά σας επιτρέπει να επιλέξετε τα HTML έγγραφα τα οποία φέρουν 
όλες τις απαραίτητες πληροφορίες σχετικά µε το µενού σας και τοποθετεί τον κώδικα 
της σύνδεσης του προγράµµατος (AllWebMenus Linking Section) στην αρχή αυτών 
των εγγράφων. Ο κώδικας σύνδεσης δίνει οδηγίες στον Browser σχετικά µε τα 
απαραίτητα αρχεία που θα δηµιουργήσει το µενού σας και κατευθύνει στις σωστές 
διαδροµές όσον αφορά κάποιες εικόνες που έχετε συµπεριλάβει σε αυτό. ∆εν 
απαιτούνται από σας γνώσεις DHTML και Javascript αφού όλη η διαδικασία 
κατευθύνεται από την εφαρµογή. Βλέπετε παρακάτω τον κώδικα και το σχόλιο µε τον 
οποίο τον αναγνωρίζουµε εύκολα.  
 
 
<!-- DO NOT MOVE! The following AllWebMenus code must always be placed right AFTER 
the BODY tag-->  
<!-- ******** BEGIN ALLWEBMENUS CODE FOR menu ******** -->  
<span id='xawmMenuPathImg-menu' style='position:absolute;top:-50px'>  
<img name='awmMenuPathImg-menu' id='awmMenuPathImg-menu' src='awmmenupath.gif' 
alt=''></span>  
<script type='text/javascript'>var MenuLinkedBy='AllWebMenus [2]', awmBN='GN'; 
awmAltUrl='';</script>  
<script charset='UTF-8' src='menu.js' language='JavaScript1.2' type='text/javascript'></script>  
<script type='text/javascript'>awmBuildMenu();</script>  
<!-- ******** END ALLWEBMENUS CODE FOR menu ******** --> 
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Η διαδικασία της σύνδεσης απαιτεί τη χρήση των 2 παρακάτω στοιχείων: 
 
 
 
 
1. Το αρχείο του µενού στο 
οποίο έχει γίνει ήδη compile 
(πχ menu.js) 
 
 
 
 
 
 
2. Τις ιστοσελίδες στις οποίες θα συνδεθεί το µενού σας. Μπορείτε, όπως βλέπετε 
παρακάτω, να επιλέξτε περισσότερες  από µία ιστοσελίδες στις οποίες θα συνδεθεί το 
µενού σας. Για χρήστες παλαιότερων browsers που δεν υποστηρίζουν DHTML, 
µπορείτε να δώσετε µια εναλλακτική διεύθυνση όπου πχ δεν θα εµφανίζετε το µενού 
στην ιστοσελίδα αλλά κάποια επιπλέον links που θα κάνουν την πλοήγηση πιο 
εύκολη.  
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ΒΗΜΑ 3 : Τοποθετήστε το µενού µέσα στην 
ιστοσελίδα 

 
Αφού λοιπόν συνδέσατε το µενού µε στις ιστοσελίδες σας, ήρθε η ώρα να το 
τοποθετήσετε στο σηµείο που θέλετε µέσα στη σελίδα χρησιµοποιώντας την ιδιότητα 
“Positioning” του Main Menu Group. Υπάρχουν δύο µέθοδοι τοποθέτησης στην 
ιστοσελίδα:  
 
Μέθοδος 1: Αυτόµατη εµφάνιση του µενού µε το άνοιγµα της σελίδας                          
(Automatically show Main Menu on page load) 
  
Η µέθοδος αυτή είναι και η πιο 
συνηθισµένη. Μπορείτε να 
τοποθετήστε το µενού είτε σε 
σχέση µε το παράθυρο του 
browser, είτε σε σχέση µε 
κάποιο στοιχείο της σελίδας 
(πίνακας, εικόνα, link κα). Ο 
πιο εύκολος τρόπος είναι ο 
πρώτος αφού δεν απαιτείται η 
χρήση καθόλου επιπλέον 
κώδικα. Έτσι λοιπόν επιλέγετε 
σε ποιο µέρος της σελίδας να 
εµφανιστεί το µενού καθώς και 
τις αποστάσεις από τα άκρα 
της. Ο δεύτερος τρόπος απαιτεί  
τη χρήση επιπλέον κώδικα αλλά  
προσφέρει µεγαλύτερη ευελιξία  
και καλύπτει όλα τα σηµεία  
τοποθέτησης στη σελίδα. Αρχικά 
λοιπόν ανοίξτε την HTML σελίδα 
σας. Στη συνέχεια επιλέξτε το στοιχείο στο οποίο θέλετε να εµφανιστεί το µενού σας. 
Τέλος προσθέτετε την ακόλουθη  παράµετρο στην ετικέτα (tag) του στοιχείου: 

id=”awmAnchor-menu” 
Στη θέση του menu πρέπει να µπει το πραγµατικό όνοµα του µενού σας ( χωρίς την 
κατάληξη .js). Μερικά παραδείγµατα εµφανίζονται παρακάτω: 
 

1. Μενού προσκολληµένο σε ένα πίνακα:  
 

<table id="awmAnchor-menu" width="150" height="150" border="1"> 
 

2.  Σε ένα Link:  
 

<a id="awmAnchor-menu" href="#">Menu attached to this link.</a> 
 

3. Σε µία εικόνα:  
  

<img src="products1.gif" id="awmAnchor-menu"> 
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Μέθοδος 2: Ανάδυση του µενού µέσα στη σελίδα (Manually trigger 
Groups as popup menus)  
 
Με αυτή τη µέθοδο έχετε τη 
δυνατότητα να δηµιουργήσετε 
αναδυόµενα µενού 
προσθέτοντας επιπλέον κώδικα 
σε κάποιο στοιχείο της σελίδας 
σας. Είναι µια πολύ ευέλικτη 
µέθοδος που µπορεί να 
αξιοποιηθεί ως εξής:  
i)  Να διατηρήσετε ολόκληρο 
το µενού κρυµµένο µέχρι να 
λάβει µέρος ένα γεγονός ( όπως
η ανάδυση του µενού όταν ο κέρσορας περάσει πάνω από ένα  link ή µια εικόνα
ακόµα και να αναδύεται το µενού στο σηµείο που θα κάνετε δεξί κλικ.  

 
) ή 

 ii)  Να επιτρέψετε κάποιο στοιχείο της σελίδας (πχ εικόνα, link) να πάρει ουσιαστικά 
τη θέση του µενού και να αναδυθεί µέσα από αυτό κάποιο υποµενού. Έτσι 
εξοικονοµείτε επιπλέον χώρο από την ιστοσελίδα σας. Για να γίνει αυτό θα πρέπει να 
δώσετε ένα συγκεκριµένο όνοµα ID στο κάθε group. Το ID του MainMenuGroup για 
παράδειγµα θα είναι gr0. Επιλέγετε και την ακριβής θέση του group σε σχέση µε το 
στοιχείο και τον τρόπο ανάδυσης. Οι ρυθµίσεις αυτές µετατρέπονται αυτόµατα σε 
κώδικα παρακάτω, και πρέπει απλά να τον επικολλήσετε στον κώδικα του στοιχείου 
της ιστοσελίδας σας.          
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ΒΗΜΑ 4 : Ανεβάστε (upload) το µενού στον server 
 
Αφού λοιπόν έχετε κάνει ήδη compile και έχετε ήδη συνδέσει το µενού στις 
ιστοσελίδες σας, θα πρέπει τώρα να ανεβάσετε τα απαραίτητα αρχεία στο server σας 
έτσι ώστε να ολοκληρώσετε την εργασία σας. Τα αρχεία που δηµιουργήθηκαν από το 
AllWebMenus κατά τη διάρκεια του compile είναι τα εξής:  
 
 ./menuname.js  
./awmmenupath.gif  
./awmdata/    (φάκελος)  
./awmdata/dot.gif  
./awmdata/[όλα τα  awmlibX.js αρχεία]  
./awmdata/[όλες οι εικόνες που χρησιµοποιούνται από το µενού]  
 
Όπου :  
 
./ ∆ηλώνει τη διαδροµή που έχετε αποθηκεύσει το µενού. 
menuname ∆ηλώνει το όνοµα που έχετε επιλέξει για το µενού σας κατά τη

διάρκεια του compile.   
 
 
Όλα τα παραπάνω αρχεία πρέπει να τα ανεβάσετε (upload) στον server σας 
χρησιµοποιώντας το αγαπηµένο σας FTP εργαλείο. Σιγουρευτείτε ότι η δοµή του 
καταλόγου θα παραµείνει ακριβώς η ίδια όπως επεξηγείται εδώ ακόµα και όταν 
φορτωθούν τα αρχεία στον server. Επίσης πρέπει να σιγουρευτείτε ότι τα αρχεία 
έχουν τοποθετηθεί στην ίδια τοποθεσία σε σχέση µε τα αρχεία HTML, όπως ακριβώς 
ήταν και στον τοπικό σας δίσκο, έτσι ώστε να λειτουργήσουν σωστά συνδέσεις που 
έχετε ορίσει και να µην αλλοιωθεί η δοµή της σελίδας. Όπως βλέπετε παρακάτω µε 
τη χρήση του Dreamweaver:    
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ΒΗΜΑ 5 : Αποθηκεύστε την εργασία σας  
 

Τέλος αφού ολοκληρώσατε την εργασία σας ήρθε η ώρα να την αποθηκεύστε. 
Μπορείτε λοιπόν να σώσετε το µενού σας ως ένα αρχείο .awm έτσι ώστε να µπορείτε 
να το χρησιµοποιήστε και να το επεξεργαστείτε όποτε επιθυµείτε. Αυτό γίνεται 
επιλέγοντας από τη γραµµή εργασίας File->Save ή File->Save As. 
 
 

 
 
 

Αν τροποποιήσετε το µενού σας θα πρέπει να το ξανακάνετε compile και να 
ανεβάσετε ξανά στο server όλα τα απαραίτητα αρχεία.  
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Παραδείγµατα 
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ΠΑΡΑ∆ΕΙΓΜΑΤΑ 
 
 
Παράδειγµα 1: Ανάδυση του µενού κάνοντας δεξί κλικ. 
 
 
Μπορείτε να αντικαταστήσετε τη λειτουργία που εκτελεί προκαθορισµένα το δεξί 
κλικ µε την ανάδυση του µενού σας σε όποιο σηµείο επιθυµείτε. Θα πρέπει λοιπόν: 
 
 

• Αρχικά να µην ξεχάσετε να θέσετε την ιδιότητα “Positioning->Manually 
Trigger Groups as popup menus” πριν κάνετε compile το µενού σας. 

 
 

• Κάντε compile το µενού µε το όνοµα πχ popup_rightclick.js και µετά 
συνδέστε το στην ιστοσελίδα σας. 

 
 

• Ανοίξτε την ιστοσελίδα και τοποθετήστε τον ακόλουθο κώδικα HTML 
ανάµεσα στα σηµεία  <head> και </head>: 

 
 

 
 
 
 
 
Παράδειγµα 2: Χρησιµοποίηση περισσότερων µενού στην ίδια σελίδα. 
 
 
 Μπορείτε να χρησιµοποιήσετε πάνω από ένα µενού στην ίδια σελίδα αρκεί να κάνετε 
compile τα µενού σας µε διαφορετικά ονόµατα και στη συνέχεια να τα συνδέσετε 
στην ίδια σελίδα. Για παράδειγµα: 
 

• Κάντε compile το menu1.js και link στην ιστοσελίδα σας  
 

• Κάντε compile το menu2.js και link στην ιστοσελίδα σας 
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Κατά τη διάρκεια της διαδικασίας αυτής, δηµιουργούνται δύο κώδικες σύνδεσης 
µέσα στον κώδικα HTML της σελίδας. Ένας για το menu1.js και ένας ακόµα για το 
menu2.js χωρίς να παίζει ρόλο η σειρά τοποθέτησης.  



Πτυχιακή Εργασία : Νιόπας Μιχαήλ  

 
<!-- DO NOT MOVE! The following AllWebMenus code must always be placed right AFTER 
the BODY tag-->  
<!-- ******** BEGIN ALLWEBMENUS CODE FOR menu ******** -->  
<span id='xawmMenuPathImg-menu' style='position:absolute;top:-50px'>  
<img name='awmMenuPathImg-menu' id='awmMenuPathImg-menu' src='awmmenupath.gif' 
alt=''></span>  
<script type='text/javascript'>var MenuLinkedBy='AllWebMenus [2]', awmBN='GN'; 
awmAltUrl='';</script>  
<script charset='UTF-8' src='menu1.js' language='JavaScript1.2' 
type='text/javascript'></script>  
<script type='text/javascript'>awmBuildMenu();</script>  
<!-- ******** END ALLWEBMENUS CODE FOR menu ******** --> 
 
 
Θα πρέπει να αποφεύγετε τη χρησιµοποίηση στοιχείων µε το ίδιο όνοµα για να µην 
υπάρχει σύγχυση, καθώς επίσης και τα πολλά µενού στην ίδια σελίδα για λόγους 
εµφάνισης και απόδοσης.    
 
 
 
 
Παράδειγµα 3: Τοποθέτηση του µενού σε συγκεκριµένο σηµείο της σελίδας. 
 
 
Μπορείτε να ορίσετε ένα συγκεκριµένο σηµείο µέσα στη σελίδα στο οποίο θα 
εµφανίζεται το µενού µε το άνοιγµα της. Αρχικά λοιπόν θα ανοίξτε την HTML 
σελίδα σας. Στη συνέχεια επιλέξτε το στοιχείο στο οποίο θέλετε να εµφανιστεί το 
µενού σας. Τέλος προσθέτετε την ακόλουθη  παράµετρο στην ετικέτα (tag) του 
στοιχείου: 
 
                                             id=”awmAnchor-menu” 
 
 
Στη θέση του menu πρέπει να µπει το πραγµατικό όνοµα του µενού σας ( χωρίς την 
κατάληξη .js). Μερικά παραδείγµατα εµφανίζονται παρακάτω: 
 

• Μενού προσκολληµένο σε ένα πίνακα: 
 

<table id="awmAnchor-menu" width="150" height="150" border="1"> 
 

• Σε ένα Link: 
 

<a id="awmAnchor-menu" href="#">Menu attached to this link.</a> 
 

• Σε µία εικόνα: 
 

<img src="products1.gif" id="awmAnchor-menu"> 
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Παράδειγµα 4: Ανάδυση διαφορετικών µενού από διαφορετικά στοιχεία  
 
 
Χρησιµοποιώντας την ιδιότητα “Positioning->Manually trigger Groups as popup 
menus”, και τοποθετώντας τον κατάλληλο κώδικα στο σωστό σηµείο µπορείτε να 
προκαλέσετε ένα µενού να αναδυθεί από κάποιο στοιχείο της σελίδας. Έστω λοιπόν 
ότι έχουµε το menu1.js και το menu2.js τα οποία θέλουµε να εµφανίζονται όταν ο 
κέρσορας περάσει πάνω από τα link “Display menu1” και “Display menu2” 
αντίστοιχα: 
 

• Επιλέγετε την ιδιότητα “Positioning->Manually trigger Groups as popup 
menus” και ρυθµίζεται που θέλετε να εµφανίζεται το µενού σε σχέση µε το 
στοιχείο και µε ποιον τρόπο. 

 
 

• Αντιγράφετε τον κώδικα που δηµιουργείτε αυτόµατα από το πρόγραµµα και 
τον τοποθετείτε στον κώδικα του στοιχείου που σας ενδιαφέρει. Έτσι θα 
έχουµε για το menu1.js τον κώδικα  

<a href="#" onmouseover="awmShowMenu('popup_shmenu1'); 

awmHideMenu('popup_shmenu2')">Display menu1</a> 

 και για το menu2.js τον κώδικα 
 

<a href="#" onmouseover="awmShowMenu('popup_shmenu2'); 

awmHideMenu('popup_shmenu1')">Display menu2</a> 

 

• Κάνετε compile και link τα µενού στην ιστοσελίδα σας  

 

Παράδειγµα 5: Ανάπτυξη του µενού µε τη χρήση πλαισίων. 
 
 
Μπορείτε από την επιλογή “Project Properties->Compile Properties->Cross Frame 
Support”  να ρυθµίσετε το µενού σας έτσι ώστε να τοποθετείται σε ένα πλαίσιο και τα 
υποµενού του να εµφανίζονται σε άλλο. Η διαδικασία είναι η εξής: αρχικά δηλώνεται 
το όνοµα του πλαισίου που θα εµφανιστούν τα υποµενού και η ακριβής θέση που 
θέλετε να εµφανίζονται. Στη συνέχεια, αφού έχετε επιλέξει “Enable Cross-Frame 
Support”, κατά τη διάρκεια του compile αντί για ένα αρχείο θα δηµιουργηθούν δύο:  
 
 

• πχ το menuname.js το οποίο θα περιέχει µόνο το κυρίως µενού  
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• και το menuname_sub.js το οποίο περιέχει όλα τα υποµενού.  
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Έτσι αν έχετε για παράδειγµα ορίσει ένα πλαίσιο στο αριστερό άκρο της σελίδας µε 
όνοµα “left_page.htm” και την κυρίως σελίδα “main_page.htm” θα πρέπει: 
 

• Το µενού menuname.js να συνδεθεί µε το αρχείο left_page.htm και 
 

• Το menuname_sub.js να συνδεθεί µε το αρχείο main_page.htm αλλά και µε 
όλες τις σελίδες που θα ανοίξουν στο κυρίως παράθυρο. 

 
 
 
Παράδειγµα 6: Χρήση Εντολών Javascript 
 
 
Το πρόγραµµα σας προσφέρει τη δυνατότητα να προσθέσετε κάποιες εντολές 
Javascript έτσι ώστε να εκτελέσετε ορισµένες πιο εξειδικευµένες λειτουργίες. Μερικά 
παραδείγµατα είναι τα εξής:  
 

• Εκτέλεση εντολής Javascript κατά την εµφάνιση ή εξαφάνιση του µενού από 
µια ιστοσελίδα(πχ µε την εντολή “alert(‘text’);” εµφανίζεται ένα µήνυµα σε 
ένα παράθυρο. 

 
• Μπορείτε επίσης και σε ένα αντικείµενο να ορίσετε µια εντολή Javascript, σε 

όποια από τις 3 καταστάσεις βρίσκεται(Normal. On Mouse Over, On Mouse 
Click) 

 
 
 
Παράδειγµα 7: Χρήση της Εντολής Link 

 
 

Με την εντολή Link µπορείτε να καθορίσετε την ιστοσελίδα ή το αρχείο που θα 
ανοίξει κάνοντας κλικ σε ένα αντικείµενο. Αν θέλετε να το πετύχετε αυτό, θα πρέπει 
να ορίζετε ως link ολόκληρη τη διαδροµή του αρχείου (path). Μερικά σωστά 
παραδείγµατα είναι τα εξής:  
 
http://www.teiser.com  
http://www.teiser.com/icd/index.html  
ftp://www.likno.com/downloads/AllWebMenus.exe  
mailto:support@likno.com  
file:////server1/testarea/test.html   ( κάνοντας link σε ένα server)  
file:///C:/testarea/test.html      (κάνοντας link στον σκληρό δίσκο) 
file:///C:/fotos/image1.jpg   (κάνοντας link σε εικόνα) 
 
Μπορείτε επίσης να κάνετε   link και σε κάποιο σηµείο µέσα στην ίδια τη σελίδα που 
βρίσκεται το µενού χρησιµοποιώντας το εργαλείο Anchor (Άγκυρα) των 
προγραµµάτων σχεδίασης ιστοσελίδας, όπως παρακάτω:  
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http://www.mysite.com/info.html#anchor 
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Παράδειγµα 8: Οριζόντια και κάθετα µενού σε συνδυασµό.  
 
 
Μπορείτε να ρυθµίσετε να εµφανίζεται το µενού οριζόντια ή κάθετα και τα υποµενού 
του, ανεξάρτητα από το κυρίως µενού, να εµφανίζονται και αυτά κάθετα ή οριζόντια. 
Για παράδειγµα : 
 

• Ρυθµίστε το main menu να εµφανίζεται κάθετα χρησιµοποιώντας την ιδιότητα  
Type->Vertical. 

 
• Επιλέξτε το υποµενού που επιθυµείτε και από την επιλογή “customize view”  

την ιδιότητα Type->Horizontal 
 
 
 
 
Παράδειγµα 9: Συµπεριφορά του µενού σε σχέση µε τη σελίδα. 
 
 
Μπορείτε να ρυθµίσετε το µενού σας έτσι ώστε να αλλάζει η συµπεριφορά του 
σύµφωνα µε τις ανάγκες της σελίδας σας. Για παράδειγµα: 
 

• Επιλέξτε την ιδιότητα “Movable->Yes” και θα µπορείτε να µετακινήσετε το 
µενού σας σε όποιο σηµείο επιθυµείτε αρκεί το µενού να έχει “Ηeader”. 

             (Has Header->Yes, Show Header)  
 
 

• Επιλέξτε την ιδιότητα “Sticky Submenus->Yes” και τα υποµενού που θα 
εµφανίζονται θα παραµένουν στη θέση τους όταν αποµακρύνεται ο κέρσορας 
από πάνω τους, µέχρι να κάνετε ένα κλικ κάπου µέσα στη σελίδα.  

 
 

•  Επιλέξτε την ιδιότητα “Menu Drifts On Scroll->Yes - Instantly On Both 
Scrolls” και το µενού θα ακολουθεί στιγµιαία τη σελίδα κατά τη διάρκεια της 
κύλισης της (είτε πάνω-κάτω, είτε δεξιά-αριστερά) παραµένοντας στο σηµείο 
που ήταν και πριν.  

 
 
  
Παράδειγµα 10: Εµφάνιση των υποµενού σε σχέση µε τα γονικά τους µενου. 
 
Έχετε τη δυνατότητα να ρυθµίσετε την εµφάνιση των υποµενού(submenus) σε σχέση 
µε τα γονικά τους αντικείµενα (items). Έτσι λοιπόν µπορείτε: 
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• Να επιλέξετε αν θέλετε το υποµενού να εµφανίζεται µε το πέρασµα του 
κέρσορα πάνω από το αντικείµενο µε την ιδιότητα “Appears-When->On 
Mouse Over of parent item”. 
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• Να επιλέξτε το υποµενού να εµφανίζεται δεξιά ή κάτω από το γονικό του µε 

την ιδιότητα “Appears-Where->Right of/Below parent group. 
 
 

• Να επιλέξτε το υποµενού να εµφανίζεται µε το εφέ “Fade” µε την ιδιότητα 
“Appears-How->Fade” 
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• Να επιλέξετε το υποµενού να εµφανίζεται κεντραρισµένο µε το γονικό του 
αντικείµενο µε την ιδιότητα “Appears-Aligned with->Centered to parent 
group”   
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ΣΥΜΠΕΡΑΣΜΑΤΑ 
 
Το AllWebMenus αποτελεί µια εφαρµογή που απευθύνεται σε όλους όσους 
ασχολούνται ή πρόκειται να ασχοληθούν µε την κατασκευή ιστοσελίδων. 
Απευθύνεται στον αρχάριο σχεδιαστή στον οποίο προσφέρει ένα πολύ απλό στην 
χρήση πρόγραµµα. Τον βοηθάει να δοµήσει την ιστοσελίδα του χωρίς να απαιτεί από 
αυτόν γνώσεις HTML και Javascript. Απευθύνεται επίσης και στους πιο έµπειρους 
σχεδιαστές εξοικονοµώντας τους πολύ κόπο και χρόνο που θα σπαταλούσαν για να 
συντάξουν µόνοι τους κώδικα. Αποτελεί µια εφαρµογή που έχει χρησιµοποιηθεί και 
χρησιµοποιείται από πολλούς σχεδιαστές ιστοσελίδων.   
 
Ο ακόλουθος είναι ένας κατάλογος από µερικές από τις επιχειρήσεις και τις 
οργανώσεις του ιδιωτικού, εκπαιδευτικού και δηµόσιου τοµέα που εµπιστεύονται το 
AllWebMenus και το χρησιµοποιούν για την παρουσία τους στο ∆ιαδίκτυο.   
 
 

Ιδιωτικός τοµέας 
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3M 
Alcatel 
American Airlines 
American Express 
Andersen Consulting 
AT&T 
AT&T Wireless 
Bank of America 
Bausch & Lomb 
BellSouth Corporation
Bell Canada 
Boeing 
BP 
Citibank 
City Financial Group 
Chevron 
Compaq 
Computer Associates 
CPI 
Deere & Company 
DuPont 
Ericsson 
FedEx 
Fidelity Investments 
Ford Motor Company 
GE 
GMAC Insurance 
Hewlett-Packard 

IBM 
Intel 
Intuit 
Johnson & Johnson 
JP Morgan 
Lockheed Martin 
Lucent Technologies 
Merck & Co. 
Merril Lynch 
MGM Studios Inc. 
Microsoft 
Motorola 
Northwest Airlines 
Philip Morris 
Qwest 
Schlumberger 
Sprint 
Sun Microsystems 
Sybase 
Thrifty Rent-A-Car 
Time Warner Cable 
Toys R Us 
Volvo 
Walt Disney World 
Wells Fargo 
Xerox 
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Εκπαιδευτικός Τοµέας 

 
Aalborg University, Denmark 
Academic Technology Center (Bemidji 
State University) 
Advising Center at Texas Tech University 
America's Clean Water Foundation 
American Military University 
Andrews University 
Athens State University 
Athabasca University, Canada 
Auraria Library 
Baylor College Of Medicine 
Brigham Young University 
Carnegie Mellon University 
Department of Nuclear Physics, Lund 
University 
Department of Pediatrics Tohoku 
University, Japan 
Embry-Riddle Aeronautical University 
EMCED 
Emory University 
Endicott College 
Environmental Council/WRC 
Erasmus University Rotterdam, 
Netherlands 
Florida Tech 
Fort Lewis College 
GA Institiute of Technology 
Georgia Southern University 
Idaho State University 
Clemson University 
Marquette University, EECE 
Middle Georgia College 
Missouri Western State College 
MIT 
ND State Coll of Science 
Northern Arizona University 
Northwood University 
Pontifical College Josephinum 
Purdue University 
Raritan Valley Community College 
Rensselaear Polytechnic Institute 
School of Biological Sciences, Manchester 
University 
Seton Hall University 

Smith College 
Southeast Missouri State University 
Stanford University 
Tilburg University, Netherlands 
Texas A&M University 
Texas Tech University 
UNC School of Medicine, Program on 
Aging 
Universite du Quebec a Chicoutimi 
University of Houston 
University of South Carolina 
University of Pennsylvania 
University of Alabama at Birmingham 
University of Arkansas Division of 
Continuing Education 
University of California 
University of Colorado 
University of Georgia 
University of Illinois at Urbana-
Champaign 
University of Iowa 
University of Michigan 
University of Nebraska Medical Center 
University of New Mexico 
University of North Carolina at Chapel 
Hill 
University of Plymouth, UK 
University of Rhode Island 
University of Richmond 
University of South Dakota 
University of Stirling, UK 
University of Washington 
UNM School of Law 
UNMC College of Dentistry 
UT College of Engineering 
UT Southwestern Medical Center 
Utah State University 
UW Madison 
Wake Forest University 
Washington University 
Webster University 
WFU ZSR Library 
Z. Smith Reynolds Library 
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∆ηµόσιος Τοµέας 

 
Arizona Public Service Company 
Brookhaven National Laboratory 
Bureau of Land Management Colorado 
State Office 
Carroll County Board of Education  
CERN 
Cincinnati State 
City of Austin 
City of Black Hawk 
City of Escondido 
City of Fresno 
City of Germantown, TN 
City of Kansas City Mo 
City of Mississauga 
City of Moscow 
City of Raleigh 
City of Riverside 
City of San Antonio 
City of Seattle 
City of St. Cloud 
City of Surrey 
City of Wichita 
City of Williamsburg 
County of Orange 
County of York 
Department of Veterans Affairs 
Delaware Army National Guard 
Douglas County Circuit Court  
Dunn County Central Transportation  
Embassy of Colombia in Japan 
FCC 

Jefferson County Colorado 
Los Alamos National Laboratory 
Ministry of Foreign Affairs and Trade, 
N. Zealand 
Nastional Institute of Standards and 
Technology 
National Renewable Energy Laboratory 
National Weather Service 
NASA - Jet Propulsion Laboratory 
New York State Education Department 
Oklahoma Medical Research Foundation
Social Services Department, UK 
South Australian Research & 
Development Institute 
Space Dynamics Laboratory/Program 
Development 
State Department Federal Credit Union 
State of Colorado 
State of ME - Dept of Education 
State of California 
US Air Force 
US Army 
US Army Corps Of Engineers 
US Army Recruiting Command 
US Navy 
US Embassy of Canada 
US Geological Survey 
US Bureau of Land Management 
US Census Bureau 
United Nations 
United States Postal Service 
Virginia Air National Guard 
Woods Hole Oceanographic Institution 
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ΒΙΒΛΙΟΓΡΑΦΙΑ 
 
1.  http://www.likno.com/   
 
 
2.  http://www.wikipedia.org/ 
 
 
3.  http://www.ietf.org/ 
 
 
4.  http://www.flashmenufactory.com/ 
 
 
5.  ΟΕ∆Β – Προγραµµατιστικά εργαλεία για το διαδίκτυο 
 
 
6.  ΟΕ∆Β – Βασικές υπηρεσίες ∆ιαδικτύου 
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